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คำนำ 
 แผนที่เดินเรืออิเล็กทรอนิกส์ หรือที่เรียกกันอย่างย่อว่าแผนที่ ENC (Electronic Navigational 
Chart) นั้น แรกเริ่ม กรผ.อศ. ได้ใช้โปรแกรมในการสร้างคือ Caris HOM ต่อมาได้เปลี่ยนมาใช้โปรแกรม 
SevenCs ENC Designer สร้างเป็นหลัก จนมาถึงต้นปี พ.ศ.๒๕๕๙ น.ท.ฤทธิเดช  เกตุทอง หน.ควบคุณ
คุณภาพ กรผ.อศ. ได้มีดำริให้ผู้ เขียนทดลองสร้างแผนที่  ENC ด้วยโปรแกรม Caris S-57 Composer 
Version 3.0 โดยสร้างจากแผนที่กระดาษหมายเลข ๑๕๖ ท่าเรือแหลมฉบัง เป็นเซลล์แรก ด้วยความที่ยังไม่
มีความรู้ความเข้าใจในเครื่องมือการใช้งาน  ทำให้แผนที่ ENC ทีส่ร้างข้ึนมานั้นไม่มีความสมบูรณ์  
 จนเมื่อผู้เขียนได้รับความกรุณาจาก กรผ.อศ. เสนอชื่อให้ไปอบรมหลักสูตร UKHO CAT B Marine 
Cartography and Data Processing Course ที่  Marine and Port Authority of Singapore ประเทศ
สาธารณรัฐสิงคโปร์ ระหว่าง ๑๗ เม.ย. – ๒๑ พ.ค.๕๙ และหลักสูตรต่อเนื่อง คือ CAT B Marine 
Cartography and Data Processing Continuation Course ณ UKHO เมือง Taunton สหราชอาณาจักร 
ระหว่าง ๒๑ ม.ค. – ๒ เมย.๖๐ ในหลักสูตรการอบรมมีการสอนการสร้างแผนที่ ENC ด้วยโปรแกรม Caris S-
57 Composer Version 3.0 ทำให้ผู้เขียนมีความเข้าใจในการใช้เครื่องมือของโปรแกรมมากขึ้น และนำมา
ต่อยอดในการศึกษาการใช้งานโปรแกรม จนสามารถสร้างแผนที่ ENC ให้สำเร็จ ถึงขั้นการส่งออกเป็นชุด
แลกเปลี่ยนข้อมูล (Exchange Set) ได ้ 
 การเรียนรู้เกี่ยวกับการใช้งานโปรแกรม Caris S-57 Composer จากคู่มือเล่มนี้ สามารถนำไป
ประยุกต์ใช้กับโปรแกรม Paper Chart Composer ที่ใช้สร้างแผนที่กระดาษ รวมถึงชุดโปรแกรมบริหาร
จัดการข้อมูลทางอุทกศาสตร์ (HPD - Hydrographic Production Database) หวังเป็นอย่างยิ่งว่าจะเป็น
ประโยชน์ต่อนักสร้างแผนที่ของ กรผ.อศ. และผู้สนใจทั่วไป หากมีข้อเสนอแนะเพ่ิมเติมหรือตรวจพบว่ามี
ข้อผิดพลาดประการใดในคู่มือเล่มนี้ ขอได้โปรดแจ้งให้ผู้เขียนหรือแผนกแผนที่เดินเรืออิเล็กทรอนิกส์ทราบ 
เพ่ือจะได้แก้ไขให้ถูกต้องและสมบูรณ์ต่อไป 

      ร.ท. 
             (กฤษดา  กลางพิมาย) 
                   ประจำแผนกแผนที่เดินเรืออิเล็กทรอนิกส์ 
         มี.ค.๖๑ 
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การติดตั้งโปรแกรม (Installation) และการเปิดใช้งานครั้งแรก 
 
1. Disable Anti Virus – ปิดแอนตี้ไวรัสก่อน 
2. Run setup.exe 
 
 
 
 
 
 
 
 
3. ติ๊ก I accept… แล้ว Next 
 
 
 
 
 
 
 
 
 
4. ติ๊ก Local Key แล้ว Next 
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5. Install 
 
 
 
 
 
 
 
 
 
6. เป็นอันเสร็จสิ้นการติดตั้งโปรแกรม ให้กด Finish 
 
 
 
 
 
 
 
 
 
 
7. เมื่อเปิดโปรแกรมข้ึนมาครั้งแรก จะปรากฏหน้าต่างดังด้านล่าง ให้กำหนดดังนี้ 
         

- Create a new file 
        - Producing Agency เลือก TH 
        - ID start ใส่ 1 
        - Subdivision start ใส่ 1 
        - Subdivision end ใส่ 1 
        - แล้วกด Next 
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8. เลือกที่จัดเก็บผลิตภัณฑ์ (Products) และส่งออกวัตถุ (Exports) แนะนำให้เปลี่ยนเป็น Drive D: หรืออ่ืนๆ 
ที่ไม่ใช่ Drive C: เพ่ือป้องกันไฟล์งานเสียหายเมื่อเวลาเครื่องคอมพิวเตอร์มีปัญหา 
 
 
 
 
 
 
 
 
 
 
 
9. Finish 

10. ตอบ Yes 2 ครั้งเพ่ือสร้างโฟลเดอร์จัดเก็บผลิตภัณฑ์ (Products) และส่งออกวัตถุ (Exports) 
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กล่าวนำ (Introduction) 

 โปรแกรม S-57 Composer เป็นโปรแกรมที่ใช้สร้าง, Update และปรับแต่งผลิตภัณฑ์หลักเพ่ือการ
ส่งออกเป็นชุดแลกเปลี่ยนข้อมูล (exchange set) หรือไฟล์เดี่ยว (stand-alone) 

 ข้อมูลผลิตภัณฑ์ประกอบด้วย 2 ไฟล์ คือ ไฟล์วัตถุทางอุทกศาสตร์แบบไบนารี่ (Hydrographic 

Object Binary,HOB) และไฟล์ผลิตภัณฑ์ (Product,PRD) โดยไฟล์วัตถุทางอุทกศาสตร์แบบไบนารี่จะเก็บ
ข้อมูลของวัตถุทางภูมิศาสตร์ ส่วนไฟล์ผลิตภัณฑ์จะเก็บข้อมูลเพื่อการอธิบาย (metadata) 

โปรแกรม S-57Composer ใช้ในการทำงานต่อไปนี้ 
  - เปิดไฟล์ข้อมูลเพ่ือสอบถามข้อมูล แสดงผล และแก้ไข 

  - สร้างชุดข้อมูลแผนที่  ENC ตามมาตรฐาน S-57 Edition 3.1 หรือ ชุดข้อมูล  AML 

Edition1.0 และ 2.0 รวมทั้งสามารถสร้างชุดข้อมูลของข้อมูลแผนที่ ENC ภาคแผ่นดิน (Inland ENC 2.0,2.1 

และ USACE 4.0) 

  - สร้างไฟล์ Update, ไฟล์รวมการ Update ครั้งก่อนจนถึงปัจจุบัน (re-issue) และแผนที่ 
ENC บรรณาธิกรใหม่ (New edition) 

- สร้างชุดแลกเปลี่ยนข้อมูล (Exchange set) 
 

แผนผังการทำงาน (workflow) 
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ตัวช่วย (Getting Assistance) 
 เมื่อมีปัญหาในการใช้งานโปรแกรม มีข้อแนะนำอยู่ 4 หนทางด้วยกันในการใช้ตัวช่วย คือ 
 1. ใช้ Reference Guide มีมากับตัวโปรแกรมแล้ว (Documentations) 
  2. ใช้ Help จากแถบเมนูโปรแกรมด้านขวาสุด 
 3. จากการทำแบบฝึกหัดในห้องเรียน หรือสอบถามจากผู้รู้ 
 4. จากแผนกบริการลูกค้าสัมพันธ์ของบริษัท CARIS 
 
ตัวช้ี (Pointers) 
 เมื่อเราเลือกเครื่องมือสำหรับการดิจิไทส์ เมาส์พอยเตอร์ก็จะเปลี่ยนแปลงไปตามแต่ละสถานการณ์ 
ดังรูปด้านล่าง 
 
 
 
 
 
 
 
 
 
 
 
 
 
ลักษณะของ Node 
 - สีเหลืองใหญ่ คือ Starting node, Share node  
 - สีเหลืองเล็ก คือ End node, Vertex  
 - สีแดง คือ Vertex หรือ Vertices ล่าสุดที่ได้ทำการดิจิไทส์ลงไปหรือถูกเลือก     
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คำสั่งลัด (Keyboard Shortcuts) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
การใช้งานปุ่มเมาส์ 
ปุ่มซ้าย ใช้ในการจัดการ Interface ทั่วไป เช่น การวางเคอร์เซอร์ในฟิลด์ข้อความ การเลือกวัตถุใน

หน้าต่างการแสดงผล การเลือกเมนู การดิจิไทส์ เป็นต้น 

ปุ่มกลาง  ใช้ในการเลื่อนหน้าจอการแสดงผล โดยการกดค้างไว้แล้วลาก รวมถึงรีเฟรชหน้าจอด้วย 
ปุ่มขวา  ใช้แสดงรายการเลือกแบบผุดขึ้น (pop-up menu) 
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คำสั่งต่างๆ ใน S-57 Composer (Commands) 
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กล่าวนำการใช้งานโปรแกรม S-57 Composer  

 ก่อนการใช้งาน S-57 Composer ผู้ใช้แต่ละคนควรที่จะตั้งค่าตัวเลือกให้เหมาะสมกับตัวเอง เพื่อการ
ใช้งานอย่างมีประสิทธิภาพ (working environment option) 

 สามารถกำหนดค่าพารามิเตอร์ต่างๆ ได้จากเมนู Tools > Options 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- ทั่วไป (General) ใช้ในการกำหนดการแสดงผล เช่น การซูม การเลื่อนหน้าจอ สีของวัตถุที่เลือก 
และอ่ืนๆ  

- หน่วยในการแสดงผล (Display unit) ใช้กำหนดหน่วยในการแสดงพิกัดตำบลที่ ระยะทาง และ
มุม 

- การแก้ไข (Editing) กำหนดค่าการ snap ที่ใช้ในการลอกลาย (digitize) หรือแก้ไขรูปลักษณ์ 
(feature) 

- สภาพแวดล้อม (Environment) ใช้แสดงตัวแปรสภาพแวดล้อมที่สัมพันธ์กับเส้นทางเข้าถึงไฟล์ 
(path) เช่น อีลิปซอยด์ การตั้งค่าสี รหัสรูปลักษณ์ เป็นต้น 

- S-52 ใช้ควบคุมการแสดงผลตามมาตรฐาน S-52 

- แสดงผล (Display) กำหนดการแสดงผลในรูปแบบต่างๆ ตามท่ีผู้ใช้ต้องการ 

- การเชื่อมต่อ (Connection) กำหนดการเชื่อมต่ออินเตอร์เนต 
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แคตาลอก (Catalogue) 
 รูปลักษณ์ (feature) และคุณลักษณะ (attribute) ในผลิตภัณฑ์ของ Composer และไฟล์ภายนอก
อ่ืนๆ ถูกกำหนดโดยแคตาลอก XML ที่อยู่ในไดเรกทอรี่ระบบ (system directory) 

 พจนานุกรม (dictionary) เป็นตัวกำหนดรูปลักษณ์และคุณลักษณะต่างๆ ที่ใช้ 
 โพรไฟล์ (profile) เป็นตัวกำหนดการเชื่อมโยงระหว่างรูปลักษณ์และคุณลักษณะ นอกจากนี้ยัง
กำหนดรายการ (list) ของรูปลักษณ์และคุณลักษณะต่างๆ ที่ใช้ 
 
ชั้นข้อมูล (Layer) และลำดับการแสดงผล (Draw Order) 

 หน้าต่าง Layers and Draw Order ใช้กำหนดว่าชั้นข้อมูลไหนเปิดทำงาน, ชั้นข้อมูลไหนแสดงผล, 
และลำดับก่อนหลังในการแสดงผลที่แสดงในหน้าต่างการแสดงผล (display window) 

 ในส่วนของแถบ (tab) Layers จะแสดงรายการวัตถุที่แสดงผลในหน้าต่างการแสดงผล (display 
window) 
 
 
 
 
 
การเลือกวัตถุรูปลักษณ์ (feature selection) 

รูปลักษณ์ท่ีจะใช้ทำงานต่างๆ เช่น การรวมพ้ืนที่ การเชื่อมเส้น การลบ การย้าย หรืออ่ืนๆ จะต้องถูก
เลือกก่อน โดยมีการเลือก 2 แบบ คือ 
 

1. Selection หมายถึงวัตถุรูปลักษณ์ท้ังหมดที่
อยู่ในหน้าต่าง Selection รวมถึง superselection ด้วย 

 
2. Superselection หมายถึงวัตถรุูปลักษณ์ 

ใดๆ ที่ถูกเลือกในหน้าต่าง Selection จะเป็นแถบสีที่
เน้นให้เด่นชัด ตามภาพคือ COALNE 

 
 
 
 
 
 



22 
 
เราสามารถกำหนดสีรูปลักษณ์ของ selection และ Superselection ได้จากเมนู Tools > Options 
 
 
 
 
 
 
 
 
 
 
ตัวเลือกคุณลักษณะ (Attribute Option) 

 สามารถปรับแต่งการแสดงผลคุณลักษณะให้เหมาะสมกับการใช้งานของแต่ละบุคคล โดยเลือกใช้
คำสั่ง  Attribute Options โดยคลิกบนพ้ืนที่ของหน้าต่าง Attribute แล้วคลิกปุ่มขวาของเมาส์แล้วเลือก 
Attribute Options 
 
 
 
 
 

 

 

 Show acronym   ให้แสดงอักษรย่อของรูปลักษณ์ เช่น BOYLAT 

 Show name   ให้แสดงชื่อรูปลักษณ์แบบเต็ม เช่น Buoy, Lateral 

 Show value   ให้แสดงค่าคุณลักษณะ เช่น 1 (white) 

 Display value as text  ให้แสดงค่าคุณลักษณะเป็นข้อความ เช่น white 

 Display value as Numeric ให้แสดงค่าคุณลักษณะเป็นตัวเลข เช่น 1 
 Left   จัดอักษรชิดซ้าย 

 Center   จัดอักษรก่ึงกลาง 
 Undefined attribute   คุณลักษณะที่ไม่ได้กำหนดค่า 

 Mandatory first   แสดงคุณลักษณะบังคับก่อน 

 Sort by profile    เรียงลำดับตามโพรไฟล์ของโปรแกรม 
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แคตาล็อกรายการวัตถุ (Object Catalogue Brower) 

 โปรแกรมได้จัดไว้ให้แล้วเพ่ือใช้ในการค้นหาข้อมูลของรูปลักษณ์และคุณลักษณะที่เกี่ยวข้อง โดยข้อมูล
ของรูปลักษณ์จะประกอบไปด้วยคำนิยาม คุณลักษณะต่างๆที่เกี่ยวข้อง อ้างอิง หมายเหตุ ส่วนข้อมูลของ
คุณลักษณะ เช่น ชื่อคุณลักษณะ ประเภทข้อมูล เป็นค่าท่ีกำหนดไว้อยู่แล้ว 

 การเปิดเบราเซอร์รายการวัตถุ (Object Catalogue Brower) เปิดได้จากเมนู Help ด้านขวาสุดของเมนู
หรือทุกครั้งที่ใส่รูปลักษณ์ใหม่ในแผนที่ คลิกท่ีปุ่ม Point Line Area ก็จะปรากฏกล่องโต้ตอบ ดังภาพ 
 
 
 
 
 
 
 
 
 
 
 
 
 
การค้นหาชื่อวัตถุรูปลักษณ์ 
 ในช่อง Object Acronym Filter หรือในช่อง Object Acronym ให้ พิมพ์หรือกดตัวอักษรชื่อย่อ 
(acronym) ตัวแรกของวัตถุรูปลักษณ์ที่ต้องการ เช่น เมื่อต้องการหา SBDARE ให้พิมพ์ S เมื่อตัวอักษรตรงกับ
ข้อมูลที่มีในเบราเซอร์รายการวัตถุ จะปรากฏรายการวัตถุท่ีค้นหาในช่อง Object Acronym ด้านขวา 
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การเปิดโปรแกรม S-57 Composer ขึ้นมาทำงาน 

- ดับเบิลคลิกท่ีไอคอนบนหน้าจอ             หรือ 

- Start > Programs > CARIS > CARIS S-57 Composer 3.0 > S-57 Composer3.0  

หน้าต่างของโปรแกรม (Application Window) 

 หน้าโปรแกรมหลักประกอบไปด้วยหน้าต่าง (window) ต่างๆ, แถบเมนู (menu bar), แถบแสดงสถานะ 
(status bar) และแถบเครื่องมือ (toolbar) 
 
 
 
 
 
 
 
 
 
 
 
 
 
หน้าต่างแสดงผล (Display Window) 

 เป็นหน้าต่างที่แสดงผลแผนที่ใช้ในการสร้าง แก้ไข จัดการรูปลักษณ์ต่างๆ ใช้เมนู เครื่องมือ และเมนู
แบบผุดขึ้น (pop-up) 
  
 
 
 
 
 
 
 
 
 เมื่อเลือกรูปลักษณ์ในหน้าต่างแสดงผล วัตถุที่ถูกเลือกจะแสดงในหน้าต่างการเลือก (selection 

window) ดังแสดงในรูปด้านล่างหัวข้อถัดไป 
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หน้าต่าง (Window) 

 ข้อมูลของวัตถุรูปลักษณ์ที่ถูกเลือกและคุณสมบัติต่างๆ จะปรากฏในแถบหน้าต่าง โดยแถบหน้าต่าง
เหล่านี้จะอยู่รอบๆ หน้าต่างแสดงผล (display window) เราสามารถย้ายไปวางในตำแหน่งที่เราต้องการได้ 
 
 

 
 
 
 
 
 
 
 
 
 
 

แถบหน้าต่างของโปรแกรม  S-57 Composer 
 

การแสดง/ซ่อน หน้าต่าง (window)  
 หน้าต่างสามารถสั่งให้แสดงหรือซ่อนได้โดยใช้ไอคอนรูปหมุดที่อยู่มุมบนขวาของหน้าต่าง 

 - ถ้าหมุดอยู่แนวตั้ง หน้าต่างจะอยู่คงท่ีในส่วน Interface 

 - ถ้าหมุดอยู่แนวนอน หน้าต่างจะถูกซ่อนไว้ โดยจะแสดงเฉพาะแถบชื่อของหน้าต่างนั้นๆ  
 
หน้าต่างคุณลักษณะ (Attribute) 

 หน้าต่างนี้ใช้แสดงข้อมูลต่างๆ เกี่ยวกับคุณลักษณะของรูปลักษณ์ที่เลือกไว้แบบ superselection โดย
จะแสดง 
 - อักษรย่อ (acronym) เป็นตัวอักขระจำนวน 6 ตัว ซึ่งเป็นตัวย่อของชื่อเต็ม 

 - ชื่อ (Name) เป็นคำอธิบายโดยย่อของคุณลักษณะ 

 - ค่า (Value) เป็นค่าที่กำหนดให้กับคุณลักษณะ 
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แถบค่าสี. (Value) ในหน้าตา่งคุณลักษณะ (Attribute) 

-  แถบที่แสดงด้วยสีเขียว หมายถึงคุณลักษณะแบบบังคับ (mandatory attribute) หากมิได้กำหนดจะ
แสดงเป็นสีชมพู (หมายความว่าต้องกำหนดเท่านั้น ไม่กำหนดไม่ได้) 
- แถบที่แสดงด้วยสีเหลือง หมายถึงคุณลักษณะที่ข้ึนอยู่กับคุณลักษณะตัวอ่ืน เช่น COLPAT (รูปแบบ
การกำหนดสี ต้องกำหนดเมื่อ คุณลักษณะ COLOUR มีค่าสีมากกว่า 1 ค่า เป็นต้น) หรือถ้าหากไม่มี
ข้อมูลก็ไม่ต้องกำหนดก็ได้ 

 
 
 
 
 
 
 
หน้าต่างส่วนประกอบ (component) 

ใช้แสดงข้อมูลเชิงพ้ืนที่ของรูปลักษณ์ที่เลือกไว้ 
 

 

 

 

 

 

หน้าต่างค่าพิกัด (Coordinate) 

 แสดงข้อมูลค่าพิกัดแต่ละจุดของ จุด หรือส่วนของเส้นที่ประกอบกันเป็นรูปร่างของวัตถุรูปลักษณ์    
โดยจะแสดงค่าพิกัด, ความลึกของเลขน้ำ, ระยะห่างระหว่างจุดสองจุด และมุมระหว่างจุดสองจุดบนเส้น 
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หน้าต่างลำดับการแสดงผล (Draw Order) 

 ใช้ในการจัดลำดับการแสดงของชุดข้อมูล โดยชั้นข้อมูลที่เปิดขึ้นมาจะแสดงด้วยสีดำ ส่วนอื่นที่ไม่แสดง
จะเป็นสีเทา 
  
 
 
 
 
 
 

 
หน้าต่างวัตถุรูปลักษณ์ (Feature) 

 ใช้ในการแสดงรูปลักษณ์พร้อมแสดงส่วนประกอบเชิงพ้ืนที่ของรูปลักษณ์ที่ไดเ้ลือกไว้  
 
 
 
 
 
หน้าต่างช้ันข้อมูล (Layer) 

 ชั้นข้อมูลแต่ละวัตถุที่แสดงผลในหน้าต่างแสดงผล (display window) โดยชั้นข้อมูลจะประกอบไปด้วย
ข้อมูลประเภทต่างๆ ดังนี้ 
 - ไฟล์ HOB ที่สร้างใน S-57 Composer (ไฟล์งาน) 
 - ผลิตภัณฑ์ ENC ที่สร้างจากข้อมูล HOB 

 - ข้อมูลย่อยของไฟล์ (เช่น ชั้นข้อมูลที่แสดงเฉพาะเส้นและเลขน้ำ) 
 - ไฟล์ภายนอกที่ใช้ประกอบการสร้างแผนที่ เช่น ไฟล์ภาพราสเตอร์ หรือไฟล์เวคเตอร์ 
 - ฯลฯ 
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หน้าต่างผลลัพธ์ (Output) 

ใช้แสดงผลการทำงานตามที่ผู้ใช้ได้สั่งการ ซึ่งเราควรจะอ่านหน้าต่างผลลัพธ์นี้เสมอๆ เมื่อทำงาน 
 
 
 
 
 
 
 
 
 

หน้าต่างแสดงภาพรวม (Overview) 

ใช้แสดงภาพรวมทั้งหมดของแผนที่ ในหน้าต่าง Overview และจะมีเส้นขอบดำหรือเทาแสดง        
ขอบเขตของหน้าต่าง Display Windows ว่าอยู่บริเวณใดของแผนที่ 

 
 
 
 
 
 
 
 
 
 

หน้าต่างแสดงความสัมพันธ์ (Relation) 

ใช้แสดงวัตถุแบบรวมกันเป็นกลุ่ม (collection object) หรือความสัมพันธ์แบบนายกับบ่าว (Master-

slave) ของวัตถุที่เลือก 
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หน้าต่างแสดงวัตถุที่เลือก (Selection) 

ใช้แสดงรายการของวัตถุที่เลือกจากหน้าต่างแสดงผล (display window) เช่น อักษรย่อ ชื่อ ประเภท
ของ Geometry  พิกัด ค่าความลึก ประเภทของวัตถุภูมิศาสตร์ ลำดับการแสดงผล เป็นต้น 

 
 
 
 
 
 
 
 
 
 

หน้าต่างแสดงคุณลักษณะของวัตถุเชิงพื้นที่ (Spatial Attribute) 

ใช้แสดงค่าความถูกต้องเชิงตำบลที่ (POSACC) และคุณภาพของตำบลที่ (QUAPOS) ของวัตถุเชิงพื้นท่ีที่
จะกำหนด 

 
 
 
 
 
 

หน้าต่างแสดงผลการตรวจสอบความถูกต้องของข้อมูล (Validation) 

ใช้แสดงผลการตรวจสอบความถูกต้องของข้อมูลในแผนที่ 
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มุมมองและเครื่องมือในการแสดงผล (Viewing and Display Tool) 
 การย่อ-ขยาย (Zoom) 
 การขยายแบบกำหนดพื้นที่ (Zoom Area) 

 วิธีการ 

 1. เลือกคำสั่ง Zoom Area 
   
 
 
 
 2. คลิกปุ่มซ้ายค้างไว้แล้วเลื่อนเคอร์เซอร์กำหนดพื้นที่ที่ต้องการขยาย 

 3. ปล่อยปุ่มซ้าย 

การขยายให้ใหญ่ข้ึน (zoom in) 
 
 
 
 
การย่อให้เล็กลง (Zoom Out) 
 
 
 
หมายเหตุ 
การ Zoom In โดยใช้ปุ่มกลางของเมาส์ที่มีล้อกลาง ให้หมุนล้อไปข้างหน้า 

การ Zoom Out โดยใช้ปุ่มกลางของเมาส์ที่มีล้อกลาง ให้หมุนล้อเข้าหาตัว 

การเลื่อนหน้าจอ (Pan) 

1. เลือกคำสั่งในการเลื่อนหน้าจอ 
 
 
 
 
Tips การเลื่อนหน้าจอโดยใช้ปุ่มกลางของเมาส์ 
คลิกปุ่มกลางของเมาส์ค้างไว้ เคอร์เซอร์จะกลายเป็นรูปมือ แล้วเลื่อนไปยังตำแหน่งที่ต้องการ 
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การเปลี่ยนมาตราส่วนในการแสดงผล (Change Scale) 

1. เลือกใช้คำสั่งเปลี่ยนมาตราส่วนในการแสดงผล 

     
 
 จะปรากฏกล่องโต้ตอบ ดังนี้ 
     
 
2. พิมพ์ตัวเลขมาตราส่วนใส่ในช่อง Enter the new scale  

3. คลิกปุ่ม OK 

หมายเหตุ มาตราส่วนในการแสดงผลจะปรากฏในแถบแสดงสถานะ (status bar) บริเวณด้านล่างของ
หน้าจอ 
 
แสดงข้อมูลทั้งหมดให้ปรากฏบนหน้าจอ (Overview) 

1. คลิกเลือกคำสั่ง 
 
 
 
 
การสั่งให้เลื่อนหน้าจอไปยังจุดศูนย์กลาง (Center On) 

รายการที่เลือกไว้แบบ Superselection 

1. เลือกวัตถุรูปลักษณ์ หรือกลุ่มของวัตถุรูปลักษณ์ตามต้องการ 

2. เลือกใช้คำสั่ง 
 
 
 
รายการที่เลือกไว้แบบ Selection 

1. เลือกวัตถุรูปลักษณ์ หรือกลุ่มของวัตถุรูปลักษณ์ตามต้องการ 

2. เลือกใช้คำสั่ง 
 
 
หมายเหตุ ไม่สามารถเลื่อนไปยังจุดศุนย์กลางของวัตถุแบบรวมกันเป็นกลุ่ม (collection object) ได ้
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การเลื่อนจุดศูนย์กลางไปยังจุดพิกัดที่ต้องการ (Coordinate) 

1. เลือกใช้คำสั่ง 
 
 
 
จะปรากฏกล่องโต้ตอบ ดังนี้ 
 
 
 
2. เลือกรูปแบบการป้อนค่าพิกัด Geographic (ค่าแลต. ลอง.) หรือค่ากริด 

3. ป้อนค่าพิกัดตามต้องการ 

4. คลิกปุ่ม OK 

5. หรือสามารถใส่ค่าพิกัดท่ี Toolbar เสร็จแล้วกดปุ่ม  
 

 

การเปลี่ยนโครงสร้างแผนที่ในการแสดงผล (Change Projection) 

1. เลือกใช้คำสั่ง 
  
 
   จะปรากฏกล่องโต้ตอบ ดังนี้ 
 
 
 
 
 
 
 
 
 
2. เลือกโซน (zone) ตามตอ้งการแล้วคลิกปุ่ม OK 
หมายเหตุ สำหรับภาพราสเตอร์ เมื่อมีการเปลี่ยนโครงสร้างแผนที่ในการแสดงผล แต่ละพิกเซลของ

ไฟล์ภาพราสเตอร์จะถูกคำนวณใหม่ตามโครงสร้างแผนที่ในการแสดงผลที่เลือก 
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การกำหนดการแสดงผล (Filtering Data in the Display) 

 สามารถสร้างชั้นข้อมูล (create layer) โดยกำหนดชุดของข้อมูลรอง โดยสามารถสร้างได้จาก 
- ค่าคุณลักษณะ (attribute value) 

- ประเภทของรูปลักษณ์ (feature type) 

- อักษรย่อ (acronym) 

- หมายเลขวัตถุรูปลักษณ์ (feature object ID,FOID) 

- อักษรย่อของรูปลักษณ์ที่ไม่ซ้ำกัน 

- การกำหนดการแสดงผลตามต้องการ (แบบซับซ้อน) 
 

การสร้างช้ันข้อมูลจากค่าคุณลักษณะ (attribute value) 

เป็นการสร้างชั้นข้อมูลโดยใช้เงื่อนไขในการค้นหาอ้างอิงกับค่าคุณลักษณะแบบตัวเลข 

วิธีการ 

1.  เลือกใช้คำสั่งสร้างชั้นข้อมูลจากค่าคุณลักษณะ 
  
 
 
 
 
 จะปรากฏกล่องโต้ตอบดังนี้ 
 
 
2. คลิกเลือกอักษรย่อของ attribute ที่หัวลูกศร ช่อง Acronym 

3. คลิกเลือกตัวดำเนินการ ที่หัวลูกศร ช่อง Operator 

4. คลิกเลือกค่าของ attribute ที่หัวลูกศร ช่อง Value 

5.  พิมพ์ชื่อชั้นข้อมูลใส่ในช่อง Layer name หรือให้โปรแกรมตั้งชื่อให้อัตโนมัติตาม Acronym, 

Operator, Value โดยคลิกปุ่มซ้ายของเมาส์ 1 ครั้งในช่อง Layer Name 

6. คลิกปุ่ม OK 

ตัวอย่าง ต้องการเลือกเฉพาะวัตถุรูปลักษณ์ที่ WATLEV = cover and uncover 
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การสร้างช้ันข้อมูลจากอักษรย่อของวัตถุรูปลักษณ์ (Feature Acronym) 

เป็นสร้างชั้นข้อมูลตามอักษรย่อของวัตถุรูปลักษณ์ ตั้งแต่ 1 วัตถุหรือมากกว่าขึ้นไป 

1.  เลือกใช้คำสั่งการสร้างชั้นข้อมูลจากอักษรย่อของวัตถุรูปลักษณ์ 
 
 
 
  
 จะปรากฏกล่องโต้ตอบ ดังนี้ 
 
 
  
2. สร้างชั้นข้อมูลโดยใช้วิธีต่อไปนี้ 
 - คลิกเลือกอักษรย่อของวัตถุรูปลักษณ์ จากเมนูหัวลูกศร โดยสามารถเลือกได้มากกว่า 1 วัตถุ 

 - คลิกที่แถบไฮไลต์สีน้ำเงินให้เป็นสีขาว แล้วพิมพ์อักษรย่อของวัตถุรูปลักษณ์ เมื่อพิมพ์ไปได้ 1 ตัว
โปรแกรมจะค้นหาให้โดยอัตโนมัติ หากยังไม่ตรงตามต้องการก็ให้พิมพ์ตัวถัดไป 

 - พิมพ์อักษรย่อของวัตถุรูปลักษณ์ (อักษรตัวพิมพ์ใหญ่เท่านั้น) ในโปรแกรมพิมพ์ข้อความ เช่น 
notepad แล้ว copy ไว้ หลังจากนั้นคลิกท่ีปุ่ม Import เลือก From Clipboard 

3.  พิมพ์ชื่อชั้นข้อมูลในช่อง Layer 

4. หากไม่ต้องการให้วัตถุรูปลักษณ์ที่กำหนดถูกเลือก ให้คลิกที่ Exclusive หมายถึงไม่เลือก ให้มี
เครื่องหมายถูก 

5. คลิกปุ่ม OK 
 

 ตัวอย่าง จะสร้างชั้นข้อมูลให้แสดงผลเฉพาะ SOUNDG (เลขน้ำ) 
 1. คลิ๊กไฮไลท์แผนที่นั้นๆ คลิ๊กขวา แล้วคลิ๊ก Create Layer>Feature Acronym… 

 2. ชั้นข้อมูลถูกสร้างขึ้นมา Layer Name : กำหนดชื่อตามต้องการ (กำหนด 111) 
 3. แล้วเลือก Feature ที่จะให้แสดงผล แล้ว OK 

 4. จะได้ Layer ใหม่ตามที่ตั้งชื่อไว้ ใน Layer 111 นี้ก็จะถูกแสดงหรือกระทำเฉพาะ SOUNDG 
เท่านั้น 
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การสร้างช้ันข้อมูลจากประเภทของวัตถุรูปลักษณ์ (Feature Type) 

เป็นการสร้างชั้นข้อมูลจากประเภทของวัตถุรูปลักษณ์ (จุด เส้น พ้ืนที่ หรือเลขน้ำ) 
1.  เลือกใช้คำสั่งชั้นข้อมูลจากประเภทของวัตถุรูปลักษณ์ 
 
 
 
 
  
 จะปรากฏกล่องโต้ตอบ ดังนี้ 
  
2. เลือกประเภทวัตถุรูปลักษณ์ตามต้องการ 

3. พิมพ์ชื่อชั้นข้อมูล 

5. หากไม่ต้องการเลือกวัตถุรูปลักษณ์ที่เลือก ให้คลิกเลือกท่ี Exclusive หมายถึงไม่เลือก 

6. คลิกปุ่ม OK 
 
ตัวอย่าง ต้องการเลือกชนิดของวัตถุรูปลักษณ์ท่ีเป็น Point และ Line 
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การสร้างช้ันข้อมูลตาม Feature ID 

เป็นการสร้างชั้นข้อมูลแบบกำหนดเองโดยใช้ข้อมูลจาก Feature ID ของวัตถุรูปลักษณ์ท่ีต้องการ 
วิธีการ 

1. เลือกใช้คำสั่งสร้างชั้นข้อมูลตาม Feature ID 
 
 
 
 
 จะปรากฏกล่องโต้ตอบ ดังนี้ 
 
 
 
 
  
2. พิมพ์ชื่อชั้นข้อมูล 

3. พิมพ์ชื่อ Feature ID ในช่องถัดมาด้านล่าง (สามารถใส่ได้หลาย Feature ID) 

5. หากไม่ต้องการเลือกวัตถุรูปลักษณ์ที่เลือก ให้คลิกเลือกท่ี Exclusive หมายถึงไม่เลือก 

6. คลิกปุ่ม OK 

ตัวอย่าง  
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การสร้างช้ันข้อมูลตาม Rule Wizard 

เป็นการสร้างชั้นข้อมูลแบบกำหนดเองโดยใช้กฎในการกำหนดการสร้างชั้นข้อมูล 

วิธีการ 

1. เลือกใช้คำสั่งสร้างชั้นข้อมูลตาม Rule Wizard 
  
 
 
 
 
 
 จะปรากฏกล่องโต้ตอบ ดังนี้ 
 
 
 
 
2. พิมพ์ชื่อชั้นข้อมูลในช่อง Layer Name 

3. คลิกปุ่ม Add เพ่ือสร้างชุดของกฎขึ้นมาใหม่ หรือคลิกท่ี Import เพ่ือดูไฟล์ที่เก็บกฎที่เคยสร้างไว้แล้ว 

   หากคลิกที่ปุ่ม Add จะปรากฏกล่องโต้ตอบ ดังนี้ 
 
 
 
 
 
 
 
 
  
4. หากต้องการเลือกสิ่งที่จะกำหนดต่อไปให้คลิกเลือก Inclusive หากไม่ต้องการเลือกสิ่งที่จะกำหนด
ต่อไปให้คลิกเลือก Exclusive 

5. คลิกท่ีปุ่ม Next 

  จะปรากฏกล่องโต้ตอบ ดังหน้าต่อไป 
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6. เลือกเงื่อนไขที่ใช้ในการกำหนดการเลือกข้อมูล เมื่อเลือกเงื่อนไขแล้วจะปรากฏในรายการข้างล่าง 
 
 
 
  
7. เพ่ือคลิกเลือกที่ลิงค์ (ตัวอักษรสีฟ้า ขีดเส้นใต้) สามารถเลือกอักษรย่อ (acronym) ประเภทของวัตถุ
รูปลักษณ์ หรือค่าได้ตามต้องการ 

8. เปลี่ยนเงื่อนไขของตัวดำเนินการ (and/or) โดยคลิกที่ลิงค ์สิ่งที่เลือกจะปรากฏในรายการ 
 
 
 
  
9. คลิกท่ีปุ่ม Next จะปรากฏกล่องโต้ตอบ ดังนี้ 
 
 
 
 
 
 
  
10. พิมพ์ชื่อกฎที่ตั้งไว้ 
11. คลิกท่ีปุ่ม Finish 

12. หากต้องการบันทึกกฎที่ตั้งไว้ให้เป็นไฟล์ CRFX ให้คลิกท่ีปุ่ม Save 

13. คลิกปุ่ม OK เพ่ือสร้างชั้นข้อมูลตามที่กำหนดไว้ 
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การเลือกวัตถุ (Selecting) 

การเลือกแบบกำหนดพื้นที่ (Select By Range) 

1. กำหนดการแสดงผลบนหน้าจอและขยายไปยังพื้นท่ีที่ต้องการ 

2. เลือกคำสั่งเลือกวัตถุแบบกำหนดพื้นที ่
 
 
 
 
3. คลิก 1 ครั้งเพ่ือเลือกวัตถุ 1 รายการ 

4. การเลือกวัตถุแบบกำหนดพ้ืนที่ กดปุ่มซ้ายของเมาส์ค้างไว้แล้วเลื่อนเคอร์เซอร์กำหนดพ้ืนที่สี่เหลี่ยม
เพ่ือเลือกวัตถ ุ

5. หากต้องการเลือกวัตถุเพ่ิมแบบกำหนดพื้นที่ ให้กดปุ่ม <Ctrl> ค้างไว้แล้วทำตามขั้นตอนที่ 4 

6. หากต้องการเพิ่มวัตถุแบบคลิกเลือก 1 รายการ ให้กดปุ่ม <Ctrl> ค้างไว้ แล้วคลิกเลือกวัตถุ 
7. หากต้องการยกเลิกการเลือกวัตถุ ให้ให้กดปุ่ม <Ctrl> ค้างไว้ แล้วคลิกซ้ำท่ีวัตถุท่ีเลือกไว้ 
8. หากต้องขยายมุมมองไปที่วัตถุที่เลือกแบบ superselect ให้ดับเบิลคลิกที่รายการของวัตถุนั้นในแถบ 
selection 

การเลือกแบบลากเส้นกำหนดพื้นที่ตามต้องการ (By Lasso) 

1. เลือกคำสั่งเลือกแบบลากเส้นกำหนดพ้ืนที่ตามต้องการ 

 เคอร์เซอร์จะเปลี่ยนเป็นรูป  

2. เลื่อนเคอร์เซอร์ไปยังจุดเริ่มต้นที่จะลากเส้นกำหนดขอบเขตการเลือก 

3. คลิกวางจุดเพื่อลากเส้นกำหนดขอบเขตให้รอบวัตถุที่ต้องการเลือก 

4. หากต้องการลบจุดล่าสุดที่คลิกวางเข้าไป ให้กดปุ่ม <Backspace> 

5. กดปุ่ม <End> เพ่ือเลือกวัตถุตามขอบเขตที่ลากไว้ 
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การเลือกวัตถุทั้งหมด (All) 

เป็นการเลือกวัตถุในชุดข้อมูลทั้งหมด โดยไม่คำนึงถึงว่าวัตถุเหล่านั้นจะปรากฏในหน้าต่างแสดงผล
หรือไม ่

ก่อนใช้คำสั่งนี้ต้องกำหนดการแสดงผลให้แสดงวัตถุที่ต้องการใช้งานให้ปรากฏในหน้าต่างแสดงผลก่อน 

วิธีการ 

เลือกคำสั่ง 
 
 
 
 
 

การเลือกวัตถุทั้งหมดที่ปรากฏในหน้าต่างแสดงผล (All in Display) 

ก่อนใช้คำสั่งนี้ต้องกำหนดการแสดงผลให้แสดงวัตถุที่ต้องการใช้งานให้ปรากฏในหน้าต่างแสดงผลก่อน 

วิธีการ 

เลือกคำสั่งเลือกวัตถุท้ังหมดที่ปรากฏในหน้าต่างแสดงผล 
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การเลือกวัตถุแบบกำหนดเอง (By Filter) 

การเลือกตามค่าคุณลักษณะ (Attribute Value) 

วิธีการ 

เลือกใช้คำสั่งการเลือกตามค่าคุณลักษณะ 
 
 
 
 
วิธีการในรายละเอียด ให้ดูเพ่ิมเติมได้จากหัวข้อ การสร้างชั้นข้อมูลตามค่าคุณลักษณะ 

การเลือกตามอักษรย่อของวัตถุรูปลักษณ์ (Feature Acronym) 

คลิกเลือกใช้คำสั่งเลือกตามอักษรย่อของวัตถุรูปลักษณ์ 

 
วิธีการในรายละเอียด ให้ดูเพ่ิมเติมได้จากหัวข้อ การสร้างชั้นข้อมูลตามอักษรย่อของวัตถุรูปลักษณ์ 
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การใส่ข้อมูล (Digitizing) 

การใส่วัตถุรูปลักษณ์ประเภทจุดสัญลักษณ์ (New Point Feature) 

วิธีการ 

1. เลือกใช้คำสั่งในการใส่จุดใหม่ 

               
 2. ในกล่องโต้ตอบ Select Object Acronym ให้ค้นหาแล้วคลิกเลือกวัตถุรูปลักษณ์ที่จะสร้างขึ้นมาแล้ว
คลิก OK 

 3. ในกล่องโต้ตอบ Attribute ให้กำหนดค่า (value) ให้กับคุณลักษณะ (attribute) ต่างๆ แล้วคลิก OK 

 4. หากต้องการใส่วัตถุรูปลักษณ์ให้ตรงตามพิกัดที่ต้องการ ให้ป้อนค่าพิกัดที่บริเวณมุมล่างซ้ายของ
กล่องโต้ตอบ 

 5. หากไม่ได้ป้อนค่าพิกัดตามข้อ 4. ให้คลิกวางจุดตามต้องการ 

 การใส่วัตถุรูปลักษณ์ที่เป็นลายเส้นหรือพื้นที่ (New Line or Area Feature) 

วิธีการ 

1. เลือกใช้คำสั่งในการใส่วัตถุรูปลักษณ์ที่เป็นลายเส้นหรือพ้ืนที่ 

 
 2. ในกล่องโต้ตอบ Select Object Acronym ให้ค้นหาแล้วคลิกเลือกวัตถุรูปลักษณ์ที่จะสร้างขึ้นมาแล้ว
คลิก OK 

 3. ในกล่องโต้ตอบ Attribute ให้กำหนดค่า (value) ให้กับคุณลักษณะ (attribute) ต่างๆ แล้วคลิก OK 

 เคอร์เซอร์ที่จะให้วางจุดของเส้นแบบ point-to-point จะเป็นรูป  แต่จะเปลี่ยนเป็นรูปอ่ืนเมื่อเลือก
เส้นเป็นประเภทอ่ืน  
 4. คลิกวางจุดบนเส้นหรือทำตามวิธีการของใส่เส้นประเภทอ่ืน เมื่อเรียบร้อยแล้วกดปุ่ม <enter> 
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 การใส่เส้น Point-to-Point Line 

วิธีการ 

 1. เลือกคำสั่งใส่เส้น point-to-point line 
         
 2. คลิกวางจุดที่ 1 

 3. คลิกวางจุดถัดไป 

 4. เลือกเปลี่ยนประเภทของเส้นโดยใช้คำสั่งใส่เส้นคำสั่งอ่ืน 

 5. เมื่อคลิกวางจุดเรียบร้อยแล้วกดปุ่ม <enter> 

 
 การใส่เส้น Stream Line 

 ลากเส้นโดยโปรแกรมจะวางจุดให้โดยอัตโนมัติไปตามแนวเส้น 

วิธีการ 

1. เลือกใช้คำสั่ง Stream line 
              
 
 
2. หากต้องการลากเส้นตรงให้คลิกที่ตำแหน่งที่ต้องการ 

3. กดปุ่มซ้ายของเมาส์ค้างไว้แล้วลากเส้นตามต้องการ 

4. ยกนิ้วออกจากปุ่มซ้ายของเมาส์เพ่ือหยุดลากเส้น 

5. ลากเส้นอ่ืนๆ โดยใช้คำสั่งในการลากเส้น 

6. เมื่อลากเส้นเรียบร้อยแล้วให้กดปุ่ม <enter> 

การใส่เส้น Squared Line 

เป็นการลากเส้นโดยมีจุดเปลี่ยนมุม 90 องศา 

วิธีการ 

1. เลือกใช้คำสั่งลากเส้นแบบ Squared line  
             
2. คลิกวางจุดที่ 1 

3. จุดถัดไป คลิกแล้วลากเมาส์ไปยังจุดที่ต้องการแล้วปล่อยปุ่มของเมาส์ 
4. เมื่อลากเส้นเรียบร้อยแล้วกดปุ่ม <enter> 
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การใส่เส้นวงกลมโดยวางจุดเส้นผ่าศูนย์กลาง 2 จุด (Circle with Two Point Diameter) 

วิธีการ 

1. เลือกใช้คำสั่ง Circle (2 diameter) 
     
                 
2. คลิกท่ีจุดแรกของแนวเส้นผ่าศูนย์กลาง 
3. คลิกจุดที่สอง 
4. จบการทำงาน ปล่อยปุ่มของเมาส์ 

การใส่เส้นสี่เหลี่ยมโดยวางจุด 2 จุด (Rectangle Using Two Points) 

วิธีการ 

1. เลือกใช้คำสั่ง Rectangle (2 points) 
                   
2. คลิกท่ีจุดที่ 1 

3. กดปุ่มซ้ายของเมาส์ค้างไว้แล้วเลื่อนเมาส์ไปยังจุดที่ 2 ตามต้องการ 

4. จบการทำงาน ปล่อยปุ่มของเมาส์ 
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การใส่เลขน้ำ (New Sounding) 

วิธีการ 

1. เลือกใช้คำสั่งใส่เลขน้ำ 
 
 
จะปรากฏกล่องโต้ตอบ Sounding Attribute ดังภาพ 
 
 
 
 
 
 
 
 
 
 
2. กำหนดค่าให้กับคุณลักษณะ ส่วนค่าความลึกให้พิมพ์ในช่อง Depth (Metres) เช่น 3.2, -1.2 
3. คลิกวางจุดที่จะวางเลขน้ำตามต้องการ หรือป้อนค่าพิกัด 

 หากเลือก Geographic หมายถึงป้อนค่าพิกัดภูมิศาสตร์ ค่า Latitude และค่า Longitude โดยมี
รูปแบบการป้อนค่าพิกัด ดังนี้ 

  - dd องศาและทศนิยมขององศา (เช่น 12.2234451N) 

  - dm องศาและลิปดา (เช่น 12-30.5N) 

  - dms องศา ลิปดา ฟิลิปดา (เช่น 12-30-30.125N) 
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การใส่วัตถุรูปลักษณ์ซ้ำ (Repeat New Feature) 

คำสั่งนี้ใช้ในการใส่วัตถุรูปลักษณ์ที่มีชื่ออักษรย่อและมีค่าคุณลักษณะเหมือนกัน 

วิธีการ 

1. เลือกใช้คำสั่งใส่จุดสัญลักษณ์ 

 
2.  เลือกอักษรย่อของวัตถุรูปลักษณ์ตามต้องการ 

3. กำหนดค่าให้กับคุณลักษณะ 

4. เลือกใช้คำสั่งสำหรับใส่วัตถุรูปลักษณ์ซ้ำ 

5. คลิกวางจุดสัญลักษณ์ตามต้องการ 

6. คลิกท่ีคำสั่งใส่วัตถุรูปลักษณ์ซ้ำ (ตามข้อ 4.) เพื่อยกเลิกการใส่วัตถุรูปลักษณ์ซ้ำ 
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การแก้ไข Geometry ของวัตถุรูปลักษณ์ (Editing Feature Geometry) 

 ข้อสังเกตุ 1. Geometry ในที่นี้หมายถึง ประเภทของข้อมูล ที่เป็นจุด เส้น พื้นที่ 
   2. วัตถุรูปลักษณ์ที่เลือกไว้แบบ superselect ซ่ึงใช้ geometry ร่วมกับวัตถุรูปลักษณ์อ่ืน ถ้า 

หากตัวเลือก Edit All Feature       (แก้ไขวัตถุรูปลักษณ์ทั้งหมด) ทำงาน การแก้ไขวัตถุรูปลักษณ์ที่เลือกแบบ 
superselect geometry ของวัตถุรูปลักษณ์อ่ืนๆ ที่เก่ียวข้องจะถูกแก้ไขไปด้วย 
 วิธีการ 

 1. เลือกวัตถุรูปลักษณ์ที่ต้องการแก้ไข 

   
 2. คลิกเลือกเครื่องมือสำหรับแก้ไขวัตถุรูปลักษณ์ ซึ่งจะเข้าโหมดแก้ไขวัตถุรูปลักษณ์ ดังภาพตัวอย่าง 

                
 จุดบนเส้น (Vertex, Vertices) จะปรากฏเป็นรูปสี่เหลี่ยมสีเหลืองอยู่บนเส้น ส่วนโหนด (node) ซึ่งเป็น
จุดบนเส้นที่ต่อเส้นเข้าด้วยกัน (จุดเริ่มต้นและจุดสิ้นสุด) จะปรากฏเป็นรูปสี่เหลี่ยมสีเหลืองที่มีขนาดใหญ่กว่า 
เมื่อจุดบนเส้น (vertex) ถูกเลือกจะเป็นสีแดง 

 
 วิธีการเลือกจุดบนเส้น (vertex) แบบต่างๆ  
เลือก vertex จุดแรก กดปุ่ม <Shift> ค้างไว้แล้วเลือก vertex จุดสุดท้าย  vertex ระหว่างจุดแรกและ       
จุดสุดท้ายจะถูกเลือก 
 
 
 
 
 
เลือก vertex ตามต้องการโดยกดปุ่ม <Ctrl> ค้างไว้แล้วคลิกเลือก vertex อ่ืนๆ  
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 การย้ายวัตถุรูปลักษณ์ประเภทจุดสัญลักษณ์ (Move a Point Feature) 
  
 
 
 
 1. คลิกเลือกวัตถุรูปลักษณ์แบบจุดสัญลักษณ์ 
 2. คลิกเลือกใช้คำสั่งเข้าโหมดแก้ไขวัตถุรูปลักษณ์ 

   

3. เลื่อนเคอร์เซอร์ไปวางบนจุดสัญลักษณ์ เคอร์เซอร์จะเปลี่ยนเป็นรูป  

4. คลิกบนจุดสัญลักษณ์ โดยจุดสัญลักษณ์จะเปลี่ยนจากสีเหลืองเป็นสีแดง หมายถึงถูกเลือกแล้ว 

5. ลากไปวางที่ตำแหน่งใหม่ 
6. ปล่อยปุ่มของเมาส์ 
7. สามารถป้อนค่าพิกัด Lat, Long ได้ในแถบ ค่าพิกัด (Coordinate) โดยต้องอยู่ในโหมด Edit Feature 
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การย้ายจุด vertex บนเส้น (Move a Vertex on an Edge) 

วิธีการ 

1. เลือกจุด vertex 

2. คลิกบนจุด vertex ค้างไว้ เคอร์เซอร์จะเปลี่ยนเป็นรูป  

3. ลากจุด vertex ไปยังตำแหน่งใหม่ ตามต้องการ 

4. ยกนิ้วออกจากปุ่มซ้ายบนเมาส์ 
 
การเพิ่มจุด vertex บนเส้น (Add a Vertex to an Edge) 

วิธีการ 
1. เลื่อนเคอร์เซอร์ไปวางบนเส้น ให้อยู่ระหว่างจุด vertex ที่มีอยู่แล้ว 

2. กดปุ่ม <Ctrl> ค้างไว้  เคอร์เซอร์จะเป็นรูป   แล้วคลิก 

ปุ่มซ้ายของเมาส์เพ่ือวาง จุด vertex บนเส้น 
 
การลบจุด vertex (Delete a Vertex) 

วิธีการ 

1. คลิกเลือกจุด vertex ที่จะลบ 

2. เลือกใช้คำสั่ง ลบจุด vertex ตามต้องการ 
 
 
การตัดเส้น (Split an Edge) 

เป็นการตัดเส้น เส้นหนึ่งให้กลายเป็น 2 ส่วน ตรงจุด vertex ที่เลือกไว้ ผลจากการตัดเส้นชื่อวัตถุ
รูปลักษณ์และคุณลักษณะ (attribute) จะยังคงเดิม 

วิธีการ 

1. เลือกจุด vertex ที่เป็นจุดตัดเส้น 

2. เลือกใช้คำสั่งตัดเส้นตามต้องการ 
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การรวมเส้น (Merge Edges) 

เป็นการรวมเส้นตั้งแต่ 2 ส่วนขึ้นไปให้เป็นเส้นเดียวกัน โดยเส้นจะต้องมีคุณลักษณะที่เหมือนกัน 

วิธีการ 

1. เลือกจุด vertex โดยคลิกปุ่ม <Shift>  (ดูรายละเอียดการเลือกจุด vertex ก่อนหน้านี้) 
2. เลือกใช้คำสั่งรวมเส้น  
 
 
 
 
 
การทำให้เส้นมีความราบเรียบ (Smooth an Edge) 

เป็นการทำเส้น spline ตามช่วงจุด vertex ที่เลือกไว้ 
วิธีการ 

1. เลือกช่วงจุด vertex ตามต้องการ โดยกดปุ่ม <Shift>  

ค้างไว้แล้วคลิกจุด vertex แรก และจุด vertex สิ้นสุด 

2. เลือกใช้คำสั่งทำเส้นให้ราบเรียบ 
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การลากเส้นใหม่ (Redigitize an Edge) 
เป็นการแก้ไขบางส่วนของเส้น  
1. กำหนดช่วงที่จะแก้ไขโดยการเลือก จุด vertex  
โดยกดปุ่ม <Shift> ในการเลือกจุด vertex 
2. เลือกใช้คำสั่งลากเส้นใหม่  
จะปรากฏเส้นตรงระหว่างจุด vertex จุดแรกและจุดสุดท้ายที่เลือก 

จุด vertex จุดแรกที่เลือกจากสี่เหลี่ยมสีเหลืองจะเปลี่ยนเป็นมีขอบสีดำ ซึ่งหมายถึงจุดเริ่มต้นที่จะเริ่ม
ลากเส้นใหม ่

3. ลากเส้นใหม่ตามต้องการตามเครื่องมือที่โปรแกรมมีให้     
4. เมื่อลากเส้นตามต้องการแล้วกดปุ่ม <Enter> 
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การทำให้เส้นสั้นลง/ยาวขึ้น (Trim/Extend an Edge) 

สามารถทำให้เส้นสั้นลง/ยาวขึ้น ได้ ณ ตำแหน่งใดๆ บนเส้น 

วิธีการ 

1. คลิกเลือกเส้น 

2. คลิกท่ีปุ่ม  เ พื่อเข้าสู่โหมดแก้ไขวัตถุรูปลักษณ์ 
3. วางเคอร์เซอร์บนเส้น (ไม่จำเป็นต้องอยู่บนจุด vertex) 

4. เลือกใช้คำสั่งทำเส้นให้สั้น/ทำเส้นให้ยาว 

 เคอร์เซอร์จะเปลี่ยนเป็นรูป  

โดยปกติคำสั่งทำเส้นให้สั้น/ทำเส้นให้ยาว จะทำเส้นให้สั้นในส่วนของเส้นที่สั้นกว่า ถ้าหากต้องการให้
ด้านสั้นของเส้นยังคงอยู่ให้กดปุ่ม <Shift> ขณะที่ทำเส้นให้สั้น 

5. คลิกวางจุดบนเส้นแล้วกดปุ่มซ้ายของเมาส์ค้างไว้แล้วเลื่อนปรับความยาวของเส้นตามต้องการ 

6. ปล่อยนิ้วจากปุ่มซ้ายของเมาส์ 
 
ทำเส้นให้สั้น (Trim) 
 
 
 
 
 
 
ทำเส้นให้ยาว (Extend) 
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คำแนะนำในการลอกลาย (Tips for Digitizing) 

เคอร์เซอร์ (Cursors) 

เมื่อคลิกเลือกเครื่องมือในการลอกลาย เคอร์เซอร์จะเปลี่ยนรูปไปตามคำสั่งที่ใช้ในโหมดลอกลาย ดังนี้ 
 

เคอร์เซอร์ คำสั่ง/โหมด คำอธิบาย 

 
Default mode (selection/query) โหมดทำงานตามปกติ 

 
Digitize point-to-point line ลากเส้น point-to-point line 

 
Digitize Squared Line ลากเส้น Squared Line 

 
Digitize stream line, fitted curve ลากเส้น stream line, fitted curve 

 
Digitize point ใส่จุดสัญลักษณ์ 

 
Digitize sounding ใส่เลขน้ำ 

 
Digitize rectangle สร้างรูปสี่เหลี่ยม 

 
Digitize arc ลากเส้นโค้ง 

 
Digitize circle สร้างวงกลม 

 
Grab Line เลือกเส้น 

 
Click within Edges คลิกในพ้ืนที่ที่มีเส้นล้อมรอบ 
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ปุ่มบนคีย์บอร์ดที่ใช้ในการลอกลาย 
 

ปุ่ม การใช้งาน 
โหมด 

(D= ลอกลาย, E=แก้ไข) 

Backspace 
ลบจุด vertex สุดท้ายที่ลอกลายเส้นหรือยกเลิก
การเลือกเส้น 

D 

Ctrl+Click ใส่จุด vertex บนเส้นในกรณีท่ีเคอร์เซอร์อยู่บนเส้น E 

Ctrl+Z ยกเลิกการทำงานก่อนหน้า E 

Delete ลบจุด vertex E 

End จบการลากเส้นหรือสร้างพ้ืนที่ D 

Enter ประมวลผลการเปลี่ยนแปลงที่มีต่อเส้น E 

Esc 

ยกเลิกการลอกลาย และยกเลิกวัตถุที่สร้าง โดยไม่
ออกจากโหมดการลอกลาย 

จบการทำงานในการวัดระยะและมุม 

D E 

C ทำเส้นปิด D 

I Snap เข้าหาจุด vertex แล้วตดัเส้น D E 

Home ทำเส้นปิดหรือพ้ืนที่ปิด D 

M รวมเส้น ณ จุด vertex ที่เลือกไว้ E 

O ทำเส้นให้มีความราบเรียบ (smooth) E 

P ตัดเส้น ณ จุดจุด vertex ที่เลอืก E 

R ลากเส้นใหม่ ที่ช่วงระหว่างจุด vertex ที่เลือก E 

S Snap เข้าหาจุด vertex D E 

Spacebar สลับจุดที่เลือกโดยการ snap E 

 
การ Snap เข้าหาจุด (Snapping) 

ขณะใส่เส้น หรือย้ายจุดบนเส้น หากต้องการให้ snap เข้าหาจุดพอดี ก่อนคลิกวางจุดให้กดปุ่ม <S> 

บนคีย์บอร์ด หรือปุ่ม <I> ค้างไว้ แล้วคลิกวางจุด 

หมายเหตุ  S = Snap 
  I = Intersect 
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การลอกลายจากภาพราสเตอร์ 

เครื่องมือในการลอกลายจะแปลงข้อมูลพิกเซลของไฟล์ภาพราสเตอร์ให้เป็นข้อมูลแบบเวคเตอร์ เมื่อ
คลิกบนภาพราสเตอร์ เครื่องมือในการลอกลายจะตรวจพบพิกเซลที่โดนคลิกและเครื่องมือจะลอกลายไปตาม
พิกเซลที่มีสีเดียวกันไปตามเส้น 

วิธีการ 

1. ตรวจให้แน่ใจว่าได้เปิดไฟล์ HOB เรียบร้อยแล้ว 

2. ตรวจสอบว่าได้เปิดไฟล์ภาพราสเตอร์และกำหนดให้แสดงผลบนหน้าจอเรียบร้อยแล้ว 

3. เลือกชั้นข้อมูล (Layer) ที่จะลอกลาย 

4. เลือกใช้คำสั่งเส้น/พื้นที่ (Line/Area) 

  
5. เลือกอักษรย่อของวัตถุและกำหนดค่าให้กับคุณลักษณะ (attribute) 

6. เลือกชั้นข้อมูลภาพราสเตอร์จากรายการในแถบเครื่องมือสำหรับการเลือก (select toolbar) 

 
7. คลิกปุ่มขวาของเมาส์ในส่วนของหน้าต่างแสดงผล (display window) แล้วเลือกคำสั่ง Vectorize 
From Raster 

  
8. คลิกบนภาพราสเตอร์ ณ จุดเริ่มต้นการลอกลาย 

9. คลิกจุดต่อไปบนเส้นที่ต้องการลอกลาย 

10. เมื่อลอกลายเส้นนั้นๆ เสร็จแล้วคลิกท่ีเครื่องมือในการลอกลาย (digitizing tool) 

    เมื่อมองในชั้นข้อมูลไฟล์ (file layer) จะเห็นลายเส้นที่ลอกลายแบบข้อมูลเวคเตอร์ 
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 การสร้างผลิตภัณฑ์ใหม่ (New Product) 

 ใช้สร้างผลิตภัณฑ์ใหม่ตามมาตรฐาน S-57 

 ผลิตภัณฑ์ของ S-57 Composer ประกอบไปด้วยไฟล์สองไฟล์คือ 

 - ไฟล์ผลิตภัณฑ์  (product file,PRD) ซึ่ งอยู่ ในรูปแบบ XML ซึ่ งประกอบไปด้วยข้อมูลเพ่ือการ
อรรถาธิบาย (meta data) 

 - ไฟล์วัตถุไบนารี่ทางอุทกศาสตร์ (Hydrographic Object Binary, HOB) ว่าง ซึ่งใช้กำหนดขอบเขตทาง
ภูมิศาสตร์และประเภทไฟล์ตามมาตรฐาน S-57 

 ไฟล์ผลิตภัณฑ์เมื่อสร้างแล้วจะบันทึกอยู่ใน C:\CARIS\S-57 Composer\30\S-57 Products\ โดย
เส้นทางเข้าถึงไดเรกทอรี่นี้จัดเก็บอยู่ในตัวแปรสิ่งแวดล้อมชื่อ uslXProductsHome 

 วิธีการ 

    เลือกใช้คำสั่งสร้างผลิตภัณฑ์ใหม่ (New Product)  

    หมายเหตุ แถบสีแดงท่ีปรากฏหมายถึงบังคับต้องกำหนดค่าให้กับช่องนั้นๆ  
ขั้นตอนที่ 1 จะปรากฏกล่องโต้ตอบ Create S-57 Product Step 1 ดังนี้ 
   
 
 
 
 
 
 
 
 1. ในช่อง Select New Product Type เลือกประเภทผลิตภัณฑ์ใหม่จากเมนูแบบ drop-down หาก
ต้องการสร้างแผนที่เดินเรืออิเล็กทรอนิกส์ (ENC) ให้เลือก ENC 

 2. ในช่อง Select Product ให้เลือก ENC 3.1 หรือ ENC 3.1.1 ตามต้องการ (ให้เลือก ENC 3.1) 

 3. คลิกท่ีปุ่ม Next 

ขั้นตอนที่ 2 จะปรากฏกล่องโต้ตอบ Create S-57 Product Step 2 ดังนี้ 
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 1. พิมพ์เลขบรรณาธิกร (edition number) ในช่อง edition หากเป็นแผนที่ ENC ออกใหม่ จะเป็น
บรรณาธิกรครั้งที่ 1 (edition = 1) ถ้าเป็น Edition 3 ให้ใส่เลข 3 
 2. พิมพ์ชื่อของผลิตภัณฑ์ (product name) ในช่อง product name โดยไม่ต้องเป็นไปตามกฏการตั้ง
ชื่อไฟล์ตามมาตรฐาน S-57 ให้สื่อความหมายกับแผนที่นั้นๆ ก็เพียงพอ 
 3. ในช่อง Issue Date และ Update Application Date ให้ใช้วันที่ปัจจุบัน หากต้องการกำหนดเป็นวัน
อ่ืนๆ ให้เลือกจากปฏิทิน (แนะนำให้ติ๊กที่ช่อง Set Date on Export) 

 4. ในช่อง Producing Agency ให้เลือกรหัสผู้ผลิตแผนที่ ENC เช่น TH หมายถึง อศ. 
 5. ในช่อง Navigational Purpose ให้เลือกจุดประสงค์เพ่ือการเดินเรือ (มีให้เลือก 6 จุดประสงค์เพ่ือ
การเดินเรือ) 
 6. ในช่อง Individual Cell Code ให้พิมพ์รหัสเซลล์ (cell code) ซึ่งเป็นตัวอักษรจำนวน 5 ตัวอักษร 

(เช่น 00112 หรือ 0112A โดยขึ้นอยู่กับหมายเลขแผนที่เดินเรือกระดาษที่นำมาสร้างแผนที่ ENC หรือขึ้นอยู่
กับการกำหนดหมายเลขแผนที่ ENC จากแผนกควบคุมคุณภาพ กรผ.อศ.) 
 7. ในช่อง comment ให้ใส่ข้อความ comment ตามต้องการ (หากเลือกเป็น ENC 3.1.1 จะปรากฏ 
STED:3.1.1 โดยอัตโนมัติ ห้ามลบออก) 

 8. คลิกท่ีปุ่ม Next 
 
ขั้นตอนที่ 3 จะปรากฏกล่องโต้ตอบ Create S-57 Product Step 3 ดังนี้ 
 
 
 
 
 
 
 
 
 
 
 
 
1. ในช่อง Vertical ให้กำหนดพ้ืนเกณฑ์ความสูง ประเทศไทย ให้เลือก 3-Mean Sea Level 

2. ในช่อง Sounding ให้กำหนดพ้ืนเกณฑ์หยั่งน้ำ ประเทศไทยใช้ LLW ให้เลือก 4-Lowest Low Water 

3. ในช่อง Compilation Scale ให้พิมพ์เลขมาตราส่วนที่ประกอบระวางแผนที่ เช่น 12000 (ไม่มี (,) คอมมา) 
4. ในช่อง Coordinate Multiplication Factor และ Sounding Multiplication Factor ไม่ต้องแก้ไข 
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5. ในช่อง Sounding Rounding ให้เลือกวิธีการปัดทศนิยมของเลขน้ำตามต้องการ (ให้เลือก IHO) 

6. ในช่อง Comment ใส่ข้อความ comment ตามต้องการ 

    ในช่อง English ให้กำหนด lexical level 0 สว่นในช่อง National หมายถึงภาษาของแต่ละประเทศ ในที่นี้
หมายถึงภาษาไทย หากต้องการให้รองรับภาษาไทยให้เลือกเป็น lexical level 2  

7. คลิกท่ีปุ่ม Next 
 
ขั้นตอนที่ 4 จะปรากฏกล่องโต้ตอบ Create S-57 Product Step 4 ดังนี้ 
 
 
 
 
 
 
 
 
 
1. ป้อนค่าพิกัด Latitude และ Longitude ที่มุมขอบในแผนที่มุมล่างซ้ายและมุมบนขวา 

 รูปแบบการป้อนค่าพิกัด 

 - องศา ลิปดา พิลิปดา DD-MM-SSN / DD-EE-SSE (เช่น 12-30-15N , 12-30-15.25N) 

 - องศา ลิปดาและทศนิยมของลิปดา DD-MMN /DD-MME (เช่น 12-30N , 12-30.15N) 

2. คลิกท่ีปุ่ม Next 
 
ขั้นตอนที่ 5 จะปรากฏกล่องโต้ตอบ Create S-57 Product Step 5 ดังนี้ 
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1. ในส่วน Exchange Set Creating ให้เลือกประเภทการสร้างชุดแลกเปลี่ยนข้อมูลว่าเป็นแบบ Create New 

Exchange Set (สร้างใหม่) หรือ Update Exiting (update ไฟล์ที่มีอยู่แล้ว) 
2. ในช่อง Exchange Set Name ให้พิมพ์ชื่อชุดแลกเปลี่ยนข้อมูลที่สร้างใหม่ โดยสามารถตั้งชื่อได้ทั้งตัวอักษร
ผสมตัวเลข 

3. ในช่อง Exchange Set Location ให้กำหนดที่อยู่ของชุดแลกเปลี่ยนข้อมูลโดยคลิกที่ปุ่ม Browse  

4. หากต้องการสร้างไฟล์ .000 อย่างเดียวให้เลือกคลิ๊กหน้าข้อความ Do Not Create or Update and 

Exchange Set During Export to S-57 ซึ่งหมายถึงไม่ต้องสร้างชุดแลกเปลี่ยนข้อมูลในระหว่างที่มีส่งออก
ข้อมูลตามมาตรฐาน S-57 

5. หากสร้างชุดแลกเปลี่ยนข้อมูลใหม่ ให้พิมพ์ข้อความ comment เพ่ิมเติมในช่อง Comment  

6. หากต้องการใส่ชื่อไฟล์แบบยาวของชุดแลกเปลี่ยนข้อมูลที่สร้างใหม่ ให้พิมพ์ชื่อในช่อง Long File Name 

7. คลิกที่ปุ่ม Next 
 
ขั้นตอนที่ 6 จะปรากฏกล่องโต้ตอบ Create S-57 Product Step 6 ดังนี้ 
 
 
 
 
 
 
 
 
 
 
 1. เลือกที่เก็บไฟล์ update ที่ได้จากการส่งออกข้อมูล 

  - Update and existing exchange set 
  - A new exchange set 
  - Both the existing and new exchange set 
 ถ้าเลือก new exchange set หรือ Both the existing and new exchange set ในช่อง Update 

Exchange Set Name และ Update Exchange Location จะพร้อมทำงาน 

 2. พิมพ์ชื่อชุดแลกเปลี่ยนข้อมูลใหม่ในช่อง Update Exchange Set Name 

 3. เลือกไดเรกทอรี่ในการจัดเก็บชุดแลกเปลี่ยนข้อมูลใหม่โดยการพิมพ์เส้นทางการเข้าถึงข้อมูลหรือ
คลิกท่ีปุ่ม Browse แล้วเลือกไดเรกทอรี่ตามต้องการ 
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ขั้นตอนที่ 7 จะปรากฏกล่องโต้ตอบ Create S-57 Product Step 7 ดังนี้ 
   
 
 
 
 
 
 
 
 
 
 
กล่องโต้ตอบนี้จะแสดงตัวเลือกต่างๆ ที่เลือกไว้ในขั้นตอนก่อนหน้านี้ 
 1. ตรวจสอบความถูกต้อง หากต้องการแก้ไขให้คลิกท่ีปุ่ม Back เพ่ือย้อนกลับไปกำหนดค่าให้ถูกต้อง 

 2. คลิกท่ีปุ่ม Finish เพ่ือสิ้นสุดการทำงาน 

 ไฟล์ HOB และไฟล์ PRD จะถูกสร้างขึ้นมา ชั้นข้อมูลจะถูกสร้างและแสดงผลในส่วนของหน้าต่างชั้น
ข้อมูล (layer window) 
 
 
 
 
 
 
 
 
 
 
  
 ชั้นข้อมูลชั้นบนจะเป็นข้อมูลเพื่อการอรรถาธิบายของผลิตภัณฑ์ ส่วนชั้นข้อมูลชั้นล่างจะเป็นข้อมูลของ
ไฟล์ HOB รวมถึง Layout คือขอบเขตของแผนที่นั้นๆ 
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ข้อมูลเพ่ือการอรรถาธิบายผลิตภัณฑ์ (เช่นเดียวกับข้อมูลที่อยู่ในไฟล์ PRD) จะแสดงผลในหน้าต่างคุณสมบัติ 
(properties window) เมื่อเลือกชั้นข้อมูลผลิตภัณฑ์  

 สำหรับแถวที่ข้อความเป็นเทาจางๆ จะเป็นข้อมูลแบบอ่านอย่างเดียวไม่สามารถแก้ไขได้ ส่วนแถวที่
ข้อความเป็นสีดำสามารถแก้ไขข้อมูลได้ตามต้องการ 
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การนำเข้าข้อมูลจากข้อมูลภายนอก (Import Objects from External Data Source) 

 รูปแบบของไฟล์ข้อมูลที่สามารถนำเข้ามาใช้งานในโปรแกรม S57 Composer 
 - S-57 format: S-57 ENC/AML (.000) CARIS S-57 Stand-alone HOB (.hob) 
 - VPF format: DNC และ TOD0 datasets 
 - Vector formats: CARIS, DGN, DXF/DWG, SHP, IFF และ GML  
 การนำเข้าข้อมูลที่ไดเ้ลือกไว้ (Import Selected Object) 

 วิธีการ 

 1. ทำให้ชั้นข้อมูลผลิตภัณฑ์ (product layer) อยู่ในสถานะพร้อมทำงาน หลังจากนั้นคลิกที่เมนู File > 

New Scratch Layer จะได้ชั้นข้อมูลชั่วคราวเพื่อนำข้อมูลจากภายนอกมาใช้งานในชั้นข้อมูลนี้ 
  - เลือก Catalog File เช่น S-57 ENC 3.1 

  - หมายเหตุ รูปลักษณ์สามารถนำเข้าไปยังชั้นข้อมูลที่ทำงานได้โดยตรงโดยไม่ต้องสร้าง Scratch 
Layer 
 2. ไปที่เมนู File > Open เพ่ือเปิดไฟล์ข้อมูลที่จะมาเป็นข้อมูล background หลังจากนั้นทำให้ชั้นข้อมูล
นั้นมีสถานะพร้อมทำงาน 

 3. เลือกรูปลักษณ์ท่ีจะนำเข้าจากไฟล์ภายนอก 

 4. คลิกที่เมนู Tool > Import Selected Objects 

 จะปรากฏกล่องโต้ตอบ ให้เลือกกำหนดตัวเลือกในการทำงานดังนี้ 
 1. Change Object Acronym จะเป็นการกำหนดวัตถุรูปลักษณ์และค่าคุณลักษณะใหม่ในระหว่างการ
นำเข้าข้อมูล 

 2. Keep Object Acronym จะยังคงใช้วัตถุรูปลักษณ์และค่าคุณลักษณะเดิมในระหว่างการนำเข้า
ข้อมูล 

 3. Feature Mapping จะใช้ไฟล์กำหนดค่าตามกฎที่กำหนดไว้ (Mapping Rule) เพ่ือกำหนดวัตถุ
รูปลักษณ์และค่าคุณลักษณะให้กับรูปลักษณ์ในระหว่างการนำเข้าข้อมูล โดยรูปลักษณ์ที่นำเข้านั้นไม่ไม่ได้เป็น
ไฟล์ตามมาตรฐาน S-57 
           
          เมื่อกำหนดค่าตามต้องการ 

          แล้วคลิกปุ่ม OK 
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 การนำเข้าข้อมูลไฟล์ CARIS (Import from CARIS File) 

 ใน ก ารน ำ เข้ า ข้ อ มู ล ไฟ ล์  CARIS จ ะ ใช้  Feature Mapping Rule File คื อ  IH f2O to ENC 3.1 

Conversion ในการแปลงรูปลักษณ์จากไฟล์ CARIS ให้เป็นวัตถุตามมาตรฐาน S-57 

 ไฟล์ในการแปลงรูปลักษณ์จากไฟล์ CARIS ให้เป็นวัตถุตามมาตรฐาน S-57 เรียกว่าไฟล์ ih_f2o.xml 

(f2o คือ feature to object) ซึ่งอยู่ใน C:\CARIS\S-57 Composer\30\system\RuleFiles 
  
 
 
 
 
 
 
 
 
 
ภายหลังจากเปิดไฟล์ CARIS แล้ว (File > Open แล้วเลือกไฟล์ CARIS) และเลือกวัตถุที่จะนำเข้าแล้ว คลิกที่
เมนู > Tool > Import Selected Objects> Selection เมื่อปรากฏกล่องโต้ตอบการนำเข้าให้คลิกเลือกที่ 
Feature Mapping แล้วเลือก IH f2O to ENC 3.1 แล้วคลิกปุ่ม OK 

หมายเหตุ   ถ้าไม่สามารถเปิ ด  Caris file ด้ วย S-57 Composer ได้  ให้  Change system locale จาก 
Thailand เป็น United Kingdom 

การนำเข้าข้อมูลไปยังไฟล์แผนที่ ENC 

 โดยทั่วไปการนำเข้าข้อมูลจากไฟล์ CARIS จะนำเข้าไปยังชั้นข้อมูล Scratch Layer ให้ Zoom เลือก 
สอบถามข้อมูล เพ่ือตรวจสอบความถูกต้องของข้อมูลที่นำเข้ามา โดยข้อมูลนั้นสามารถเลือกแล้วนำเข้าไปยัง
ไฟล์แผนที่ ENC ต่อไป 

 วิธีการ ให้คลิกวัตถุที่ต้องการจาก Scratch Layer แล้วคลิกที่เมนู Import Import Selected Objects> 

Selection เมื่อปรากฏกล่องโต้ตอบให้เลือก Keep Object Acronym เมื่อกำหนดค่าต่างๆ เรียบร้อยแล้วคลิก
ที่ปุ่ม OK 

 หากต้องการบันทึกไฟล์ที่ได้จากการนำเข้าข้อมูลคลิกที่เมนู File > Save หากต้องการยกเลิกให้คลิก 
File > Undo หลังจากนั้นให้ปิดไฟล์ CARIS ที่ปรากฏเป็นฉากหลังออกไปเนื่องจากไม่ต้องใช้งานแล้ว 
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 รีจิสเตอร์ (Register) 

 รีจิสเตอร์หมายถึงการทำภาพราสเตอร์หรือข้อมูลเวกเตอร์ให้มีค่าพิกัดท่ีถูกต้อง 

 วิธีการรีจิสเตอร์ภาพราสเตอร์นามสกุล .TIFF  (ด้วยวิธีการเดียวกัน แต่ปรับเปลี่ยนเล็กน้อย สามารถ
ประยุกต์ใช้กับการรีจิสเตอร์ข้อมูลเวกเตอร์ได้) 
 1. ตรวจสอบว่าไฟล์ภาพราสเตอร์หรือข้อมูลเวกเตอร์แสดงผลบนหน้าจอแล้ว และได้เลือกชั้นข้อมูลนั้นแล้ว 

 2. เลือกใช้คำสั่งรีจิสเตอร์ 

   

  เมื่อถึงตอนนี้โปรแกรมจะอยู่ในโหมดรีจิสเตอร์ ถ้ารีจิสเตอร์ภาพราสเตอร์นามสกุล .TIFF ภาพ
ราสเตอร์จะสามารถมองเห็นได้แบบโปร่งแสง 

  สามารถเลือกตัวเลือกในการรีจิสเตอร์ได้จากเมนูแบบ pop-up ในส่วนของหน้าต่างแสดงผล (display 
window) 
  
 
 
 
 
 
 
 

โดยปกติ ตัวเลือก Move or Resize Image (ย้ายหรือปรับขนาดภาพ) และ Affine (ประเภทการ 

ทรานส์ฟอร์มแบบหนึ่ง) จะถูกเลือกไว้โดยอัตโนมัติ 
3. ปรับขนาดภาพให้ใกล้เคียงกับขอบเขตที่จะใช้เป็นจุดอ้างอิงในการรีจิสเตอร์ 
 - การปรับขนาดภาพ ให้เลื่อนเคอร์เซอร์ไปที่ขอบของภาพราสเตอร์ กดปุ่มซ้ายของเมาส์ค้างไว้แล้ว
เลื่อนเคอร์เซอร์เพ่ือปรับขนาดภาพ 

 - การย้ายภาพ ให้เลื่อนเคอร์เซอร์ให้อยู่บนภาพ กดปุ่มซ้ายของเมาส์ค้างไว้แล้วเลื่อนเคอร์เซอร์เพื่อ
ย้ายภาพไปยังตำบลที่ที่ต้องการ 

อาจต้องใช้การซูมสลับกับเครื่องมือในการเลือก (selection tool) เพ่ือย้ายภาพไปยังตำบลที่ที่ต้องการ 

4. คลิกปุ่มขวาของเมาส์บริเวณหน้าต่างแสดงผล (display window) แล้วเลือก Registration > Insert 

Control Point จากเมนูแบบ pop-up เพ่ือใส่จุดควบคุม 
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 ตอนนี้ภาพราสเตอร์จะแสดงผลแบบไม่โปร่งแสง เคอร์เซอร์จะเปลี่ยนเป็นรูป  เพ่ือใส่จุด
ควบคุม (control point)  

 สำหรับจำนวนจุดควบคุมจะขึ้นอยู่กับประเภทของการทรานส์ฟอร์ม โดยการทรานส์ฟอร์มแบบ 
Affine จะใช้จุดควบคุมอย่างน้อย 3 จุด ส่วน Polynomial (2nd Degree) ต้องใช้จุดควบคุมอย่างน้อย   
6 จุด 

 5. เลือกประเภทของการทรานส์ฟอร์มเพ่ือใช้ในการรีจิสเตอร์จากเมนูแบบ pop-up 

 6. คลิกวางจุดบนภาพราสเตอร์ที่จะใช้ในการรีจิสเตอร์ 
 7. กดปุ่มซ้ายของเมาส์ค้างไว้แล้วลากลูกศรให้อยู่เหนือพิกัดที่จะใช้เป็นจุดควบคุมบนหน้าต่าง
แสดงผล (display window) 

 8. คลิกท่ีลูกศรให้อยู่บนพิกัดที่จะใช้เป็นจุดควบคุม 

 9. ทำซ้ำตามขั้นตอนที่ 6 ถึง 8 เพื่อวางจุดควบคุมให้ครบ 
  
 
 
 
 
 
 
 
 รูปสี่เหลี่ยมสีเหลืองแสดงถึงจุดบนภาพราสเตอร์และหัวลูกศรแสดงถึงจุดพิกัดที่ใช้ในการรีจิสเตอร์ 
โดยถ้ารูปสี่เหลี่ยมและลูกศรเป็นสีแดงหมายถึงถูกเลือกไว้ 
 หากอยู่ในโหมดรีจิสเตอร์ สามารถใช้กดปุ่มบนคีย์บอร์ดเพ่ือทำงานต่างๆ ได้ดังนี้ 
 - Delete ลบจุดควบคุมที่ทำงานอยู่ในปัจจุบัน 
 - Backspace ลบจุดควบคุมจุดล่าสุดที่ใส่เข้าไป 

 - Enter ทำให้การรีจิสเตอร์เสร็จสมบูรณ์ 
 - Space Bar สลับระหว่างย้ายภาพหรือปรับขนาดภาพ (Move or Resize Image) และโหมดใส่
จุดควบคุม (Insert Control Point) 

 - ปุ่มตัว S  snap เข้าหาจุดของข้อมูลเวกเตอร์ที่มีค่าพิกัดที่ถูกต้องแล้ว 
 -  Esc ยกเลิกการทำงานหรือออกจากการทำงานในการรีจิสเตอร์ 
10. หากต้องการจบขั้นตอนรีจิสเตอร์ให้กดปุ่ม <enter> 

 เมื่อถึงตอนนี้ภาพราสเตอร์หรือข้อมูลเวกเตอร์จะถูกทำให้มีพิกัดที่ถูกต้องเรียบร้อยแล้ว 
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การสร้างวัตถุ ENC แบบพิเศษ (Create Product-Specific S-57 Feature) 

 การสร้างความสัมพันธ์แบบนายกับบ่าว  (Master-Slave Relationship) 

 การสร้างความสัมพันธุ์แบบนายกับบ่าวโดยอัตโนมัติ (Automatic)  

 วิธีการ 

 1. เลือกวัตถุท่ีเป็นจุดสัญลักษณ์ (point) ทั้งหมด 

 2. เลือกใช้คำสั่งสร้างความสัมพันธ์แบบอัตโนมัติ (Automatic) 

   
 3. คลิกปุ่ม OK 

 การสร้างความสัมพันธ์ Master-Slave โดยกำหนดเอง (Manual) 

 วิธีการ 

 1. เลือกวัตถุท่ีจะมีความสัมพันธ์แบบ Master 

 2. เลือกวัตถุท่ีจะมีความสัมพันธ์แบบ Slave 

 3. เลือกใช้คำสั่งสร้างความสัมพันธ์แบบกำหนดเอง (Manual) 

   
  
 การสร้างวัตถุแบบรวมกันเป็นกลุ่ม (Collection Object) 

 ใช้สร้างวัตถุแบบรวมกันเป็นกลุ่มจากวัตถุที่เลือกตั้งแต่ 2 วัตถุข้ึนไป 

 คำสั่งนี้ใช้เฉพาะเมื่อต้องสร้างวัตถุแบบรวมกันเป็นกลุ่มเท่านั้น (ดูรายละเอียดได้จากมาตรฐาน S-57) 

 วิธีการ 

 1. เลือกวัตถุรูปลักษณ์ที่จะสร้างเป็นวัตถุแบบรวมกันเป็นกลุ่ม 

 2. เลือกใช้คำสั่งสร้างวัตถุแบบรวมกันเป็นกลุ่ม 

   
  จะปรากฏกล่องโต้ตอบ ดังนี้ 
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 3. เลือกอักษรย่อ (acronym) ของวัตถุแล้วคลิก OK จะปรากฏกล่องโต้ตอบให้กำหนดค่าของ attribute 

ต่างๆ 

 4. กำหนดค่าให้กับ attribute แล้วคลิกปุ่ม OK 

 วัตถุแบบรวมกันเป็นกลุ่มจะถูกสร้างขึ้นมาและวัตถุรูปลักษณ์ท่ีใช้สร้างวัตถุแบบรวมกันเป็นกลุ่มจะ
ยังคงถูกเลือกไว้ 
 จะปรากฏกล่องโต้ตอบของการแก้ไขวัตถุแบบรวมกันเป็นกลุ่ม ดังนี้ 
   
 
 
 
 
 
 
 
 
 
 5. คลิกปุ่ม OK แล้วคลิกท่ีปุ่ม Close  

 

กำหนดค่าค่ามาตราส่วนต่ำสุดที่ยังคงแสดงผล (SCAMIN Values) 

 คำสั่งนี้ใช้กำหนดค่ามาตราส่วนต่ำสุดที่ยังคงแสดงผล (scale minimum display)ให้กับวัตถุรูปลักษณ ์

 ค่า SCAMIN จะมีวิธีการคำนวณ 2 วิธี คือโดยใช้ scale factor หรือ step medthod (ตามมาตรฐาน   

S-65) ส่วนค่า SCAMIN ของเลขน้ำจะมีการคำนวณแยกต่างหาก 

 ในโปรแกรม S57 Composer จะมีไฟล์ที่เกี่ยวข้องกับการคำนวณ SCAMIN อยู่ 3 ไฟล์ คือ 

 1) assignscamin.xml จะเป็นไฟล์ที่ mapping การใช้ scale factor ในการคำนวณ SCAMIN ของวัตถุ
รูปลักษณ์ประเภทจุด เส้น และพ้ืนที่ 
 2) S65_ScaminMapping.xml จะเป็นไฟล์ที่  mapping การใช้วิธีการตามมาตรฐาน S-65 ในการ
คำนวณ SCAMIN ของวัตถุรูปลักษณ์ประเภทจุด เส้น และพ้ืนที่   

 3. sdgparm.txt จะเป็นไฟล์ที่ใช้ scale factor ในการคำนวณSCAMIN ของเลขน้ำ 
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สามารถแก้ไขไฟล์ทั้ง 3 ได้โดยใช้โครงสร้างและไวยากรณ์ (syntax) ของไฟล์เดิม 

 วิธีกำหนดค่า SCAMIN 

 1. เลือก HOB layer 

 2. เลือกวัตถุรูปลักษณ์ที่จะกำหนดค่า SCAMIN 

 3. เลือกคำสั่งกำหนดค่า SCAMIN 

   
  จะปรากฏกล่องโต้ตอบ ดังนี้ 
  
 
 
 
 
 4. ที่ช่อง Mapping Rule Table คลิกปุ่ม Browse เพ่ือเลือกไฟล์ที่ใช้ในการคำนวณ SCAMIN (โดยปกติ
จะเป็นไฟล์ assingscamin.xml หรือ S65_ScaminMapping.xml) -  

 5. ที่ช่อง Sounding Table คลิกที่ปุ่ม Browse เพ่ือเลือกไฟล์สำหรับคำนวณ SCAMIN ของเลขน้ำ (โดย
ปกติจะเป็นไฟล์ sdgparm.txt) 

หรือกำหนดดังนี้ 
Mapping Rule Table :  
C:\CARIS\S-57 Composer\30\system\S-65_ScaminMapping.xml 
Sounding Table : 
C:\CARIS\S-57 Composer\30\system\sdgparm_S-65.txt 

 6. คลิกปุ่ม OK 

 ค่า SCAMIN จะถูกกำหนดให้กับวัตถุรูปลักษณ์ที่เลือก 

 ผลการกำหนดค่า SCAMIN จะแสดงผลในหน้าต่างผลลัพธ์ (output window) 
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จัดกลุ่มเลขน้ำ (Group Soundingsa) 

 คำสั่งนี้ใช้จัดเก็บเลขน้ำหลายๆ ตัวที่มีค่า attribute เหมือนกันให้เป็นเลขน้ำกลุ่มเดียวกัน 

 เลขน้ำที่จัดเป็นกลุ่มจะแสดงในโปรแกรม S-57 Composer เป็นวัตถุรูปลักษณ์ของเลขน้ำเพียงตัวเดียว 
เลขน้ำที่จัดเป็นกลุ่มจะช่วยเพิ่มประสิทธิภาพในการจัดเก็บข้อมูลเลขน้ำ 

 เลขน้ำที่จัดเป็นกลุ่มเดียวกันจะมีเลขน้ำได้สูงสุด 8,000 ตัว 

 เลขน้ำที่จะจัดเป็นกลุ่มเลขน้ำจะต้องอยู่ภายใต้เงื่อนไขต่อไปนี้ 

- ต้องเป็นเลขน้ำที่แยกกันและไม่เป็นส่วนหนึ่งของเลขน้ำที่จัดกลุ่มแล้ว 

- ต้องไม่เป็นส่วนหนึ่งของวัตถุแบบรวมกันเป็นกลุ่ม (collection object) 

- ต้องเป็นวัตถุรูปลักษณ์ของเลขน้ำและมี attribute เชิงพ้ืนที่ (spatial) เหมือนกัน 

วิธีการ 

1. เลือกคำสั่งจัดกลุ่มเลขน้ำ 

  
 จะปรากฏข้อความในแถบ Output เพ่ือแสดงจำนวนเลขน้ำที่ถูกจัดเป็นกลุ่ม วัตถุรูปลักษณ์ของเลข
น้ำที่จัดเป็นกลุ่มจะแสดงผลในหน้าต่างการเลือก (selection window) 
  
 
 
 
 
 
 
 
 หากต้องการจัดกลุ่มเลขน้ำเฉพาะเลขน้ำที่เลือก ให้ใช้คำสั่ง Group Selection จากเลขน้ำที่เลือกไว้ 
 วิธีการ 

 1. เลือกเลขน้ำที่ต้องการจัดกลุ่ม 

 2. เลือกคำสั่ง Group Soundings 

  
 เลขน้ำที่เลือกไว้จะถูกจัดกลุ่มให้เป็นวัตถุรูปลักษณ์ของเลขน้ำเพียง 1 วัตถุ 
 หมายเหตุ หากต้องการแก้ไขเลขน้ำที่จัดเป็นกลุ่มแล้ว จะต้องยกเลิกการจัดกลุ่มเลขน้ำก่อน โดยคลิก
เลือกเลขน้ำที่ต้องการยกเลิกการจัดกลุ่มแล้วคลิกที่เมนู > Tools > Ungroup Soundings > Selection 
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การยกเลิกการจัดกลุ่มเลขน้ำ (Ungroup Sounding) 

 วิธีการ 

 1. เลือกเลขน้ำที่ต้องการยกเลิกการจัดกลุ่ม 

 2. เลือกคำสั่ง Ungroup Sounding 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
. 
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ตรวจสอบความถูกต้องของแผนที่ ENC (Validation checks) 
เป็นการตรวจสอบความถูกต้องของแผนที่ ENC ตามมาตรฐาน S-58 ขององค์การอุทกศาสตร์สากล 

หัวข้อการตรวจสอบ (Test) รายการตรวจสอบ 

 

ตรวจสอบว่าไม่มีวัตถุซ้ำซ้อนกันที่พิกัดเดียวกัน (อยู่ในคลาสเดียวกัน มี
คุณลักษณะเหมือนกัน มีพิกัดเดียวกัน) 

 ตรวจสอบว่าไม่มีวัตถุรูปลักษณ์ต้องห้าม 

 
ตรวจว่าประเภทของข้อมูล (จุด เส้น พื้นที่) ตรงตาม Object class 

 
ตรวจสอบ Attribute ว่ามีค่าตรงตามที่กำหนด 

 
ตรวจ Attribute ที่บังคับต้องกำหนดค่า 

 ตรวจสอบความสัมพันธ์แบบ Spatial ระหว่างวัตถ ุ

 
ตรวจสอบพ้ืนที่ทับซ้อนของวัตถุท่ีอยู่ใน object class เดียวกัน 

 
ตรวจว่าไม่มีส่วนของเส้นซ้ำซ้อนกัน (duplicate) 

 ตรวจว่าไม่มีเส้นสองเส้นที่ตัดกันโดยไม่มีโหนดรองรับ 

 
ตรวจความซ้ำซ้อนของ เส้น จุดสัญลักษณ์ และเลขน้ำ 

 
ตรวจว่าไม่มีจุด vertex อยู่บนเส้นตรง 

 
ตรวจเส้นทุกเส้นที่มีโหนดเทียมที่สามารถต่อ (merge) กันได้ 

 
ตรวจเส้นของวัตถุรูปลักษณ์ 

 
ตรวจวัตถุที่เป็นพ้ืนที่ที่มี object class เดียวกัน มี attribute เหมือนกัน ที่
ต้องรวม (merge)พ้ืนที่เข้าด้วยกัน 

 
ตรวจวัตถุประเภทจุดสัญลักษณ์ที่ อยู่ ใน object class เดียวกันและมี 
attribute เหมือนกับวัตถุประเภทพื้นท่ี 

 
ตรวจวัตถุประเภทลายเส้นที่มีเส้นทับซ้อนกับพ้ืนที่ของวัตถุประเภทพ้ืนที่ที่
อยู่ใน object class เดียวกันและมี attribute เหมือนกัน 

 
- ตรวจเลขน้ำที่ต้องจัดกลุ่ม 

- ตรวจเลขน้ำในกลุ่มเดียวกันว่ามีพิกัดและมี attribute เหมือนกันหรือไม ่

- ตรวจว่าไม่มีเลขน้ำในกลุ่มไม่เกินกว่า 8,000 ตัว 

 
ตรวจว่าวัตถุแบบรวมกลุ่มมีวัตถุอย่างน้อย 2 วัตถุ 

 
ตรวจความสัมพันธ์แบบนายกับบ่าว (Master-Slave) 
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ตรวจความถูกต้องของทิศทาง การใช้งาน และการซ่อน 

 
ตรวจพืน้ที่ความลึกน้ำและเส้นชั้นความลึกดังนี้ 
* ตรวจสอบ DEPARE ที่ไม่ได้มีการ share edges กับ DEPCNT  

* ตรวจสอบค่าของ DRVAL1 and DRVAL2 ของ DEPARE ทั้งหมดว่ามีความ
สอดคล้องกับค่า VALDCO หรอืไม่  

 
ตรวจสอบ M_COVR 

 
ตรวจสอบ Meta Object (รวมถึง M_COVR ด้วย) 

 
ตรวจวัตถุรูปลักษณ์ ในกลุ่มที่  1 (skin of the earth) และวัตถุเพ่ือการ
อรรถาธิบายข้อมูล 
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แนวทางการแก้ไข Errors และ Warnings ใน CARIS S-57 Composer 

QC Tests 
No Validation Check Massages แนวทางการแก้ไข 
1 Duplicate Objects ตรวจสอบว่าไม่มีวัตถุซ้ำซ้อนกันที่พิกัดเดียวกัน (อยู่ในคลาส

เดียวกัน มีคุณลักษณะเหมือนกัน มีพิกัดเดียวกัน) 
Option : ให้ check box ตามรูป 

 
2 Prohibited Objects ตรวจว่าไม่มีวัตถุรูปลักษณ์ต้องห้าม แก้ไขให้ถูกต้องและครบถ้วน 
3 Prohibited Primitives ตรวจว่าประเภทของข้อมูล (จุด เส้น พื้นที่) ตรงตาม object 

class 
แก้ไขให้ถูกต้องและครบถ้วน 

4 Invalid Attributes ตรวจสอบ Attribute ว่ามีค่าตรงตามที่กำหนด แก้ไขให้ถูกต้องและครบถ้วน 
5 Mandatory Attributes ตรวจหาคุณลักษณะบังคับที่ยังไม่ได้กำหนด กำหนดค่าคุณลักษณะบังคับให้กับวัตถุรูปลักษณ์นั้นๆ 
6 Invalid Geometry ตรวจหา Geometry ที่ไม่สมบูรณ์  แก้ไขให้ถูกต้องและครบถ้วน 
7 Overlapping Areas ตรวจหาพ้ืนที่ ติดกัน/ทับกัน ที่อยู่ใน object class เดียวกัน Edit>Edges>Intersect / แก้ไข 
8 Overlapping Edges ตรวจว่าไม่มีส่วนของเส้นซ้ำซ้อนกัน (duplicate) Edit>Edges>Intersect 
9 Intersecting Edges ตรวจหาเส้นที่ตัดกันแต่ไม่มี Node รองรับ 

 
เลือกเส้นทั้งหมด แล้ว Edit>Edges>Intersect 

10 Redundant Edges, Points and Soundings ตรวจหาเส้นที่มี Vertices เยอะ พร้อมจุดและตัวเลขน้ำ ใช้คำสั่ง Repair All จากหน้าต่าง Validation  
11 Edges with Redundant Vertices ตรวจหาเส้นที่มี Vertices เยอะมากเกินไป Select All แล้วใช้คำสั่ง Repair All จากหน้าต่าง Validation 

12 Edges to Merge ตรวจหาเส้นที่มีคุณลักษณะเหมือนกันต้อง Merge กัน Select All แล้วใช้คำสั่ง Repair All จากหน้าต่าง Validation 

13 Line to Merge ตรวจหาเส้นที่ใช้ Node ร่วมกัน (Feature and Attributes) Select All แล้ว Edit>Lines>Merge Matching 
14 Area to Merge ตรวจสอบพื้นที่ติดกัน มีคุณลักษณะเหมือนกัน ต้องรวมกัน Select All แล้ว Edit>Areas>Merge Matching 
15 Point Inside Area ตรวจสอบหาวัตถุที่เป็นพื้นที่แล้วมีจุดที่เหมือนกันกับพื้นที่ ให้ลบจุดนั้นๆ 
16 Lines Bordering Areas ตรวจหาพ้ืนที่และมีเส้นล้อมรอบ และมีคุณลักษณะเหมือนกัน 

 
17 Edges only Used by Areas xxx Test should not be run as this test. xxx ไม่ต้อง Run/UKHO 
18 S-58 Grouped Soundings - ตรวจสอบว่ามีการจัดกลุ่มเลขน้ำหรือยัง 

- ตรวจเลขน้ำในกลุ่มเดียวกันว่ามีพิกัดและมี attribute เหมือนกัน
หรือไม ่ และตรวจว่าไม่มีเลขน้ำในกลุ่มไม่เกินกว่า 8000 ตัว 

- ถ้ายังให้ Tools>Group Soundings>All 
- ให้ Run test ก่อนและหลังการ Group Soundings 

19 S-58 Collection Features ตรวจสอบการรวมกลุ่มของวัตถุ Create>Collection from Selections… 
20 S-58 Master-Slave Relationships ตรวจสอบการสร้างความสัมพันธ์ระหว่างนายกับบ่าว Create>Master-Slave Relationships (Auto/Manual) 
21 S-58 Orient/Usage/Mask Flags ตรวจสอบ Orient/ Usage/Mask Flags Select All แล้วใช้คำสั่ง Repair All จากหน้าต่าง Validation 

22 S-58 Depth Areas and Depth 
Contours 

ตรวจสอบความถูกต้องของพื้นที่และเส้นชั้นความลึกน้ำ แก้ไขให้ถูกต้อง 

23 S-58 Data Coverage ตรวจสอบความสมบูรณ์ของวัตถุรูปลักษณ์ในกลุ่มที่ 1 และวัตถุ
เพื่อการอรรถาธิบาย 

แก้ไขให้ถูกต้อง 

24 S-58 Meta Object Coverage ตรวจสอบ M_QUAL และ M_NSYS  ให้สร้าง M_QUAL และ M_NSYS 
25 S-58 Group 1 Area Coverage ตรวจสอบ Group 1 (Skin of the Earth) แก้ไขให้ถูกต้อง 

Customized QC Tests 
No Validation Check Massages หมายเหตุ 
1 S-58 4.2 Level 1 Feature and attribution tests ตรวจสอบวัตถุและคุณลักษณะที่กำหนด แก้ไขให้ถูกต้อง 
2 S-58 4.2 Level 2 Spatial consistency and validity ตรวจสอบความถูกต้องเชิงพื้นที่ แก้ไขให้ถูกต้อง 
3 S-58 4.2 Level 3 Spatial relationships checks between features ตรวจสอบความสัมพันธ์ระหว่างวัตถุ แก้ไขให้ถูกต้อง 
4 S-58 4.2 Level 4 Collections and m/s relationship tests ตรวจสอบการรวมกลุ่มและความสัมพันธ์ของ m/s แก้ไขให้ถูกต้อง 
5 S-58 4.2 Level 5 General Metadata tests ตรวจสอบ Metadata แบบทั่วไป แก้ไขให้ถูกต้อง 
6 S-58 4.2 Level 6 Product specific metadata and hierarchy tests ตรวจสอบข้อมูลเฉพาะของ Metadata ตามลำดับ แก้ไขให้ถูกต้อง 
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วิธีการตรวจสอบ 

1. เลือกคำสั่งตรวจสอบความถูกต้องของแผนที่ ENC 
  
 
 
 จะปรากฏกล่องโต้ตอบ ดังนี้ 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. (ทางเลือกเพ่ิมเติม) สามารถกำหนดการแสดงผลรายการตรวจสอบได้โดยคลิกเลือกที่ Large Icons 

จะแสดงไอคอนขนาดใหญ่ หากคลิกที่ Small Icons จะเป็นไอคอนขนาดเล็ก หากเลือก Details จะ
แสดงรายละเอียดมาให้ 
ผู้ใช้สามารถสั่งให้ตรวจสอบความถูกต้องจาก Validation Check หรือจากไฟล์ Customized quality 

control แต่เลือกได้แบบใดแบบหนึ่ง ไม่สามารถเลือกพร้อมกันได้ 
การสั่งให้ตรวจสอบความถูกต้องจาก Validation Check List 

วิธีการ 

1. เลือกรายการตรวจสอบ 1 รายการหรือมากกว่าโดยใช้วิธีเลือกต่อไปนี้ 
 - คลิกเลือกที่รายการตรวจสอบรายการใดรายการหนึ่งเพียง 1 รายการให้ปรากฏเป็นแถบเน้นสี 
(highlight) 
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 - หากต้องการเลือกรายการตรวจสอบเป็นช่วง ให้คลิกเลือกรายการแรก กดปุ่ม <shift> ค้างไว้และ
เลือกรายการตรวจสอบรายการสุดท้ายเพ่ือเลือกรายการตรวจสอบจากรายการแรกถึงรายการสุดท้าย 

 - หากต้องการเลือกรายการแบบกำหนดเอง ให้คลิกเลือกรายการใดรายการหนึ่ง กดปุ่ม <Ctrl> ค้าง
ไว้ แล้วคลิกเลือกรายการตรวจสอบรายการอื่นตามต้องการ 

 หากรายการตรวจสอบใดมีทางเลือกเพ่ิมเติม (option) ปุ่ม Options จะอยู่ในสถานะพร้อมทำงาน 
2. คลิกปุ่ม Options เพ่ือกำหนดตัวเลือกเพ่ิมเติมก่อนสั่งให้ตรวจสอบความถูกต้อง จะปรากฏกล่อง
โต้ตอบของ Options ตัวอย่างดังนี้ 
  
 
 
 
 
 
  
 3. คลิกให้มีเครื่องหมายถูก หรือคลิกซ้ำให้เครื่องหมายถูกหายไป ตามต้องการแล้วคลิกปุ่ม OK 
 การสั่งตรวจสอบความถูกต้องจาก custom file 

 4. คลิกเลือก Customized QC Test ให้มีเครื่องหมายถูก รายการตรวจสอบใน Validation Checks 

จะเป็นสี เทาไม่สามารถสั่ งให้ตรวจสอบความถูกต้องในส่วนนั้นได้  ในขณะที่ รายการในส่วน 
Customized QC Test จะมีสถานะพร้อมทำงาน 

 5. เลือกไฟล์สำหรับการตรวจสอบในตารางโดยการคลิกเลือก 
 6. หากต้องการทราบข้อมูลของการตรวจสอบให้คลิกท่ีปุ่ม Test Info 
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การสั่งเริ่มตรวจสอบความถูกต้อง 
1. หากต้องการบันทึก log file ที่เก็บผลการตรวจสอบความถูกต้องให้คลิกที่ปุ่ม Browse ให้คลิกเลือก
โฟลเดอร์ที่จัดเก็บข้อมูลและตั้งชื่อไฟล์แล้วคลิกที่ปุ่ม Save 

2. คลิกท่ีปุ่ม Begin เพ่ือสั่งให้เริ่มต้นตรวจสอบความถูกต้องตามรายการตรวจสอบที่เลือกไว้ 
3. หากต้องการหยุดตรวจสอบความถูกต้องให้กดปุ่ม <Esc> 

 หากวัตถุรูปลักษณ์ใดตรวจสอบแล้วไม่ผ่าน จะปรากฏการเชื่อมโยง (hyperlink) กับหมายเลขของ
วัตถุรูปลักษณ์ (FOID) ในหน้าต่างตรวจสอบความถูกต้อง (Validation window) ดูภาพตัวอย่างข้างล่าง 
4. คลิกท่ีการเชื่อมโยง (link) เพ่ือดูวัตถุรูปลักษณ์ 

 เมื่อคลิกการเชื่อมโยงที่ FOID โปรแกรมจะแสดงผลวัตถุรูปลักษณ์นั้นบริเวณกลางหน้าจอ และวัตถุ
รูปลักษณ์นั้นจะถูกเลือกแบบ superselected ซึ่งสามารถแก้ไขวัตถุรูปลักษณ์นั้นให้ถูกต้องต่อไป 
  
 
 
 
 
 
 
 

 หมายเหตุ หากวัตถุรูปลักษณ์นั้นมีการแก้ไขการเชื่อมโยงใน Validation Window จะไม่สามารถใช้
งานได้อีกต่อไป ซึ่งจะต้องสั่งตรวจสอบความถูกต้องใหม่อีกครั้ง 
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ส่งออกชุดข้อมูลตามมาตรฐาน S-57 (Export to S-57) 

 คำสั่งนี้ใช้ในการสร้างชุดแลกเปลี่ยนข้อมูล (S-57 Edition exchange set) ที่มีเซลล์หลัก (base cell) 

และไฟล์ Update หรือสร้างไฟล์ Update ของชุดแลกเปลี่ยนข้อมูลที่มีอยู่แล้ว 

 ชื่อคำสั่งในการส่งออกข้อมูลจะขึ้นอยู่กับประเภทของการส่งออกข้อมูล หากส่งออกเป็นชุด
แลกเปลี่ยนข้อมูลใหม่ (new exchange set) หรือส่งออกเป็นแผนที่รวมการ Update ครั้งก่อนจนถึงครั้ง
ปัจจุบัน (re-issue) คำสั่งจะปรากฏเป็น File > Export to S-57 New Edition  

 หากเปิดแผนที่ ENC ให้เป็น Update คำสั่งจะปรากฏเป็น File > Export to S-57 New Update 

 โฟลเดอร์จัดเก็บข้อมูลจะอยู่ที่ ...\\CARIS\S-57 Composer\<version_number>\S-57 Exports 

 ชื่อไฟล์จะเป็นไปตามมาตรฐานการตั้งชื่อไฟล์แผนที่ ENC โดยชื่อไฟล์จะตั้งตามข้อมูลที่ป้อนเข้า
โปรแกรมในขั้นตอนสร้างผลิตภัณฑ์ใหม่ (New Product) 

 วิธีการส่งออกข้อมูล 

 1.เลือกคำสั่งส่งออกข้อมูล 

  
 ไฟล์แผนที่ ENC จะถูกสร้างโดยอัตโนมัติ ส่วนผลการส่งออกข้อมูลจะปรากฏในหน้าต่างผลลัพธ์ 
(output window) 
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 การปรับปรุง S-57 Catalogue  (S-57 Catalogue Maintenance) 

 คำสั่งนี้ใช้ในการสร้างชุดแลกเปลี่ยนข้อมูลใหม่ (new exchange set) หรือแก้ไขชุดแลกเปลี่ยนข้อมูล 
โดยสามารถเพ่ิมไฟล์เข้าไปยังชุดแลกเปลี่ยนข้อมูลที่มีอยู่แล้วหรือชุดแลกเปลี่ยนข้อมูลใหม่ 
 ไม่จำเป็นต้องเปิดไฟล์แผนที่  ENC ในโปรแกรม S-57 Composer ก่อนใช้คำสั่ งปรับปรุง S-57 
Catalogue 
 วิธีการ 

1. คลิกเลือกคำสั่ง  
 
 

  
จะปรากฏกล่องโต้ตอบ ดังนี้ 
  
 
 
 
 
 
 
 
 
 
 
2. คลิก Select เพ่ือแก้ไขชุดแลกเปลี่ยนข้อมูลเดิม หรือคลิก Create New เพ่ือสร้างชุดแลกเปลี่ยน
ข้อมูลใหม่ 
3. คลิก Validate  เพ่ือตรวจสอบความถูกต้อง 
4. คลิก Apply เพ่ือบันทึกการเปลี่ยนแปลงไปยังไฟล์ CATALOG.031 ของชุดแลกเปลี่ยนข้อมูล 

5. คลิก Close เพ่ือปิดกล่องโต้ตอบ 
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การแก้ไขชุดแลกเปลี่ยนข้อมูล (Edit Exchange Set) 

1. คลิกท่ีปุ่ม Select เพ่ือเลือกชุดแลกเปลี่ยนข้อมูล 

2. เลือกชุดแลกเปลี่ยนข้อมูลตามต้องการ แล้วคลิกท่ีปุ่ม OK 

 หากโปรแกรมไม่สามารถค้นหาไฟล์ CATALOG ของชุดแลกเปลี่ยนข้อมูล จะปรากฏกล่องโต้ตอบให้
เลือกโฟลเดอร์และโปรไฟล์ (profile) ที่ใช้ตามประเภทของผลิตภัณฑ์ 

3. เลือก catalogue จากเมนูแบบ drop-down แล้วคลิกปุ่ม OK 

 จะปรากฏกล่องโต้ตอบ ดังนี้ 
 
 
 
 
 
 
 
 
 
 
 
  
ไฟล์ที่อยู่ในชุดแลกเปลี่ยนข้อมูลจะแสดงผลในกล่องโต้ตอบ โดยมีตัวเลือกให้เลือก 3 ตัวเลือกคือ 
Reissue (รวมการ update ครั้งก่อนจนถึงปัจจุบัน) Cancel (ยกเลิก) และ Remove (ลบ) ถ้าหาก
ตัวเลือกดังกล่าวไม่สามารถใช้กับไฟล์ที่เลือกได้ กล่องตัวเลือกจะเป็นสีจางๆ (ไม่พร้อมทำงาน) 
4. คลิกเลือกตัวเลือกให้มีเครื่องหมายถูก ตามต้องการ 

5. หากมีความจำเป็น สามารถเพ่ิมไฟล์ได้ 
6. คลิกท่ีปุ่ม Validate 

7. คลิกท่ีปุ่ม Apply เพ่ือบันทึกการเปลี่ยนแปลงของไฟล์ CATALOG.031 ของชุดแลกเปลี่ยนข้อมูล 
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การสร้างชุดแลกเปลี่ยนข้อมูลใหม่ (New Exchange Set) 
 

  
 
 
 
 
 
 
 
 

1. Tools>S-57 Exchange Set Editor… 
2. คลิ๊ก Create New 

 
 
 
 
Product Type : ENC 
Exchange Set Name : TH40147B_Edition1 
(สามารถตั้งชื่อผสมได้ระหว่างตัวอักษรและตัวเลข) 
 
Exchange Set Location : Folder ที่เก็บข้อมูล 
 
คลิ๊ก Apply 
 
 
Add file : S-57 dataset (.000) และ 
ถ้ามีไฟล์จำพวก chart notes, รูปภาพ หรือ  
Readme text สามารถใส่รวมเข้าไปในขั้นตอนนี้  
ให้คลิ๊ก Add File 
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อันดับแรกเลือก S-57 dataset file แล้ว Open 
 
 
 
 
 
S-57 dataset file จะเข้าไปอยู่ในรายการที่เลือก 
 
ต่อไปเลือกไฟล์จำพวก chart notes 
คลิ๊ก Add File 
 
ไปที่ Folder ที่ chart notes อยู่ 
แล้วเลือกไฟล์ที่ต้องการ  
แล้วคลิ๊ก Open 
 
 
 
 
 
สังเกตุ จะมีไฟล์ที่เลือกเข้ามาอยู่ในรายการ 
 
ต่อไปคลิ๊ก Validate เพ่ือตรวจสอบ 
ความถูกต้องอีกครั้ง ถ้าข้อมูลถูกต้อง 
ปุ่ม Validate จะกลายเป็นสีเทา 
(Inactive) 
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 พิมพ์แผนที่ (Print) 

 คำสั่งนี้ใช้ในการสั่งพิมพ์แผนที่ไปยังเครื่องพิมพ์ที่กำหนดไว้ 
 การตั้งค่าก่อนพิมพ์ 

1. ตรวจสอบว่าได้เปิดไฟล์แผนที่และแสดงผลบนหน้าจอเรียบร้อยแล้ว 

2. กำหนดค่าการพิมพ์เพ่ือเลือกเครื่องพิมพ์ ขนาดกระดาษ การวางตัวบนกระดาษ ตามต้องการ 

  
 

การสั่งพิมพ์แผนที่ 
1. เลือกคำสั่งพิมพ์แผนที่ 
2. เลือกตัวเลือกในการพิมพ์ 

3. คลิกปุ่ม OK   


